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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Implementation Guide provides information and instructions to help you 
effectively implement Oracle Email Center.

This preface explains how the Implementation Guide is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Anyone implementing Oracle eMail Center

This guide assumes you have the following prerequisites:

■ Understanding of the company business processes

■ Knowledge of products and services as defined by your marketing policies

■ Basic understanding of Oracle

Structure
This guide contains the following sections:

■ eMail Center Overview

■ Application Architecture

■ Email Processing
vii



■ Planning the Implementation

■ Integration Dependencies

■ Installation

■ Implementation

■ Troubleshooting

■ Abbreviations

■ Glossary

■ Related Documentation and Resources

Related Documents
For more information, see the following manuals:

■ Oracle Email Server Installation and Configuration Guide

■ Oracle Email Server Implementation Guide
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Implementing Oracle eMail Center

This document contains the following sections:

■ eMail Center Overview

■ Application Architecture

■ Email Processing

■ Planning the Implementation

■ Integration Dependencies

■ Installation

■ Implementation

■ Troubleshooting

■ Abbreviations

■ Glossary

■ Related Documentation and Resources

eMail Center Overview
Oracle eMail Center is a complete solution for managing both inbound and 
outbound email interactions with customers, partners, suppliers, employees and 
other entities that interact with an organization.

Incoming email can be broadly categorize into structured and unstructured types. 
Structured emails are created by filling out a form or a template, it can be any text 
template or an HTML form on the WWW. Unstructured emails are typical, free 
form text messages.
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Abbreviations
Oracle eMail Center invokes appropriate, customizable processes that are targeted 
to handle different types of inbound email interactions. Workflow processes are 
setup to automatically resolve inbound structured email. Unstructured inbound 
email is passed through Oracle interMedia Text processing to determine the intent 
of the message. Workflow processes are then setup to attempt automatic resolution 
of these interactions based on the message intent/classification. Inbound 
interactions that cannot be automatically resolved are routed to the appropriate 
human agent in the Interaction Center using both rule and skill based routing 
schemes.

Once an email message gets to an agent, the eMail Center provides tools and 
capabilities to maximize agent productivity and effectiveness by providing 
fully-formed suggested responses for inbound emails and a high-performance 
point-and-click agent interface that minimizes the need for typing, includes a 
spellchecker, and the ability to attach or insert appropriate documents. Oracle eMail 
Center allows storage and retrieval of documents, URLs and images from 
Marketing Encyclopedia System (MES). eMail Center also allows interMedia text 
queries on both the Marketing Encyclopedia System (MES) and the Solution 
Management System (SMS) knowledge bases.

In addition to managing inbound email interactions, eMail Center provides 
capabilities to initiate and manage outbound interactions. System generated or 
external application generated notifications can be automatically sent as emails, 
whose format adheres to all the business practices configured into the system.

Email-based sales, marketing, and advertising campaigns can also be executed. 
Oracle eMail Center can process campaign lists, expand the campaign content 
material, add tracking tags, and send personalized emails to addresses in the list.

Abbreviations
API - Application Programming Interface

CRM - Customer Relationship Management

eMC - Email Center

HTML - Hyper Text Markup Language

IEM - Product code for eMail Center

IH - Interaction History

IMAP - Internet Messaging Access Protocol

JMA - Java Mail API
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Application Architecture
JSP - Java Server Pages

JTF - CRM Foundation Layer

KB - Knowledge Base

KMS - Knowledge Management Systems

MES - Marketing Encyclopedia System

NLS - National Language Support

OES - Oracle Email Server

OTM - Oracle Telephony Manager

SMS - Solution Management System

SMTP - Simple Mail Transport Protocol

URL - Universal Resource Locator

UWQ - Universal Work Queue

WWW - World Wide Web

Application Architecture
The following main components comprise Oracle eMail Center:

Agent Interface
A Java Server Pages (JSP) based application that runs on the agent interface in a 
browser. The supported browser is Microsoft Internet Explorer 5.0 and higher. It 
utilizes two Java Applets, an editor applet that allows the user to compose messages 
and select the font, color, formatting, etc., and it also allows importing of images 
(both .gif and .jpg files) and the second is a hidden applet, which maintains a 
connection with the Universal Work Queue Selector. This applet allows the 
exchange of information between eMC and UWQ.

System Administration Interface
A Java Server Page (JSP) based graphical user interface allows defining, viewing, 
monitoring and controlling system behavior.
Implementing Oracle eMail Center 3
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Operations Manager Interface
A Java Server Page (JSP) based graphical user interface allows authorized 
interaction center domain experts (operations managers) to configure operational 
rules or business practices for eMail Center and to specify business process 
attributes.

eMail Center Server
Is made up of a Java Server and a few database components. The Java server 
delivers information derived from an email message to the OTM server for routing 
and delivery to an appropriate agent(s). The main database component is the 
workflow based rules engine that process all inbound email messages. It can be 
customized to process emails based on different email parameters.

Oracle Email Server (OES)
Is the mail server. The emails here can be accessed through JMA – IMAP APIs or 
through PL/SQL APIs.

Database Configuration
Oracle Email Server and Oracle eMail Center can be configured to be installed on 
two separate database instances or on the same instance. Both configurations are 
supported.

Other Modules, Servers and Components

CRM Foundation Modules
eMail Center uses several features of the CRM Foundation product, such as the 
common MES (Marketing Encyclopedia System), Universal Work Queue, 
One-to-One Fulfillment, and Interaction History. Of these, MES facilitates the 
evaluation of unstructured email. The other features essentially integrate eMail 
Center with the agent interface and the rest of CRM.

Routing Server
Routes job items (telephony and email interactions) to agents and agent groups 
based on configurable skills and rules parameters.

OTM server
The Oracle Telephony Manager, holds the state of all the agents, and maintains the 
distribution queues for all interactions. These interactions include email, telephony, 
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Application Architecture
faxes, and web calls. OTM drives the router (actually a server, too) to determine 
which agents are to receive an email or telephone call. OTM receives the email from 
eMail Center and sends it to the router.

The output of the router is a list of agents qualified to handle the interaction. Based 
on this list, OTM distributes the email. "Distribute" in this case means that it puts 
the email into the queue of an agent, or the queue of an agent group, that the router 
identified.

This process occurs once for every new email. Although many agents might see the 
email in their queue, only one agent will service the interaction. Upon delivering 
the email to an agent, OTM removes it from all other agent queues. When an agent 
selects the email from the queue, OTM fires an event to the agent interface. When 
this happens, the agent might see a screen pop with a subset of the information 
contained in the email interaction.

Apache server
Apache is a third party product that handles HTML messages, such as email, 
between the source database and the agent interface. Some Oracle CRM and ERP 
products, such as Accounts Receivable, are forms driven. They require a forms 
server to interpret and display database information. Newer CRM products, like 
eMail Center, use HTML instead of forms. The Apache server and the internet 
browser work to display the information. The Apache server manipulates HTML 
email objects between the eMail Server database, sometimes call the Message Store, 
and the agent interface (an email client) using HTTP. The agent interface runs an 
internet browser, such as Netscape.

Application Configuration
 These figures show a typical and an alternate configuration of the various servers.
Implementing Oracle eMail Center 5



Application Architecture
6 Oracle eMail Center Implementation Guide



Application Architecture
Implementing Oracle eMail Center 7



Email Processing
Email Processing
The eMail Center process flow diagram describes events that occur when the eMail 
Center handles inbound or outbound email messages, as well as events on the agent 
interface during those events.

As defined earlier incoming emails can be either structured or unstructured based 
on the message content/format.

An outbound message can be a single message or a bulk mailing.

Single messages can be automatic replies to structured or unstructured inbound 
messages. Messages can also be manually created agent interface.

Bulk mailing is initiated by a CRM business application, such as Customer Care, 
that creates a mailing list and requests a message template.

eMail Center Processing Overview
The following diagram and numbered process flow depicts the start to finish 
system processing flow for eMail Center.
8 Oracle eMail Center Implementation Guide



Email Processing
1. Inbound email arrives at the SMTP Server.

2. OES attempts to place the email ID into AQ1.

■ OES (Oracle Email Server) lets eMC know that a new email has arrived by 
executing a server-side rule that places the email ID in AQ1.

■ AQ (Advanced Queuing) is a feature of the Oracle 8i database that provides 
asynchronous notification between components. In this case, AQ1 items are 
picked up by the unstructured workflow that is initiated by the Concurrent 
Manager.

3. OES delivers the incoming message to the appropriate account inbox folder if 
the email ID was successfully put in to AQ1.
Implementing Oracle eMail Center 9
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■ If the email ID could not be put in to AQ1, the incoming message 
is delivered to the RETRY folder of the appropriate account.

■ Later (controlled by the administrator), eMC processes items in the retry 
folder and attempts to put the email IDs of these items into AQ1.

4. Concurrent Manager launches the unstructured email processing workflow.

■ The unstructured email processing workflow (WF) picks up the next email ID 
from AQ1 and begins processing the associated email.

■ A node in the WF determines whether the email is structured or unstructured.

■ If the email is structured, the structured email processing WF is invoked.

■ (go to step 5B)

■ If the email is unstructured, the appropriate path in the unstructured processing 
WF is executed, based on the OES account to which the email was delivered.

■ The account is a business account, such as “support”,  “service”, “sales”, or 
“marketing”. Later in this diagram, the email message is moved to the account 
of an agent associated with the business account.

■ (go to step 5A)

5. (5B) The structured email processing WF executes.

■ WF executes the appropriate structured email path, based on the structured 
email type ID in the message. 

■ For example, if the structured email type ID indicates that it is a “Get 
Service Request Status” query, the corresponding WF path in the structured 
email processing WF is executed.

■ Each path in the structured email processing WF should be designed to 
automatically process the corresponding email message.

■ Nodes in the WF path make API calls to the CRM applications.

■ They leverage application data and functionality to automatically process 
the interaction.

■ When the processing path is completed, an API call is made to Fulfillment.

■ Creates and sends an automated response.

■ Uses the response template specified in the API call.

■ In case a processing error is encountered, the email is treated as unstructured 
and sent back to the unstructured email processing WF.
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(5C) Fulfillment creates the email message to be sent out.

■ It picks up the specified response template from MES.

■ If the response template contains merge fields, it attempts to expand the merge 
fields, either by:

■ Running the query associated with the response document (if any), or by

■ Using any merge field values that were passed to it directly via the API call 
from the workflow.

(5D) Fulfillment sends out the email message.

■ The email auto-response is sent out via the SMTP server.

■ Structured email processing is completed.

(5A) Unstructured email processing continues.

■ Execute any user defined business rules / procedures to analyze the email.

■ If desired, the iMT based automated intent analysis is performed to generate 
suggested classifications and suggested responses for the email being 
processed.

■ Check to see if auto-response is needed.

(5A1) Unstructured email auto-response.

■ If an interaction needs to be handled as an auto-response:

■ Send a request to Fulfillment to send out the auto-response.

■ Use the specified response template and merge field expansion data / 
query.

■ Go to steps 5C and 5D

■ Unstructured email processing is completed.

■ An auto-response can be generated for an unstructured email either: 

■ If a rule has been defined in the workflow to send out an auto-response 
when the rule is satisfied, or

■ If the confidence levels on the top suggested classification and associated 
top suggested response are above pre-defined confidence limits.

(5A2) Unstructured email manual (agent) response.
Implementing Oracle eMail Center 11
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■ Additional implementation specific unstructured email processing (if any) is 
done and the email ID, along with other metadata, is delivered to AQ2.

■ AQ2 is another advanced queuing notification, similar to AQ1.

■ AQ2 is an asynchronous notification between the unstructured workflow 
and the eMC server.

6. eMC Server fetches the metadata from AQ2.

7. eMC Server delivers the metadata to OTM.

8. OTM sends the metadata to and gets back route destinations from the Routing 
Server.

■ The Routing Server evaluates implementation specific static or dynamic routing 
rules to determine route destinations for the email message.

■ The Routing Server specifies which individual agents can receive the email    
message. (The individual agents are the route destinations).

■ If an agent group qualifies for the email message, the Routing Server identifies 
all the agents in the group as route destinations.

■ The route destination information is sent to OTM.

9. OTM adds the email item to the personal queue of each agent specified by the 
Routing Server.

■ OTM keeps track of the status of all the agent queues. It manages the agent 
queues.

10. In the agent work area, the agent requests the next media item (email) from the 
UWQ GUI.

■ Agent selects the appropriate email account / campaign in UWQ and clicks on 
the “Get Work” button in the UWQ GUI.

■ The UWQ GUI form invokes the UWQ Client bean.

11. UWQ Client sends the “Get Work” request to UWQ Server.

■ It specifies which agent is making the request.

Note: Step 9 is the end of the email driven process. That is, the 
arrival of a new email message triggers the processing described up 
to this point.
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■ If specifies that the request is for the next email item.

12. UWQ Server passes the “Get Work” request to the OTM Server.

13. (13A) OTM passes the “Get Work” request to the eMC Server.

(13A1) The eMC Server makes a call to OES to move the appropriate email message 
from the account inbox to the agent’s email folder inbox.

(13A2) OES executes the request.

■ OES moves the email message content from the account Inbox to the agent’s 
folder.

(13B) OTM passes the email item metadata to the UWQ Server. The metadata 
contains:

■ Media item type (email, telephony, …)

■ Email ID (MSG_ID)

■ Sender’s email address

■ Other key value pairs

14. UWQ Server passes the metadata to the UWQ Client.

15. (15A) UWQ Client pops the business application and sends it the metadata so 
that fields in the business application screen are filled appropriately.

■ In most cases, the sender’s email address from the incoming message is used to
identify the customer and populate the business application form with the 
appropriate customer information

(15B) UWQ Client pops the eMC Agent GUI (eMC AG) to the “Preview” screen. 
The actual message content is retrieved from agent’s folder in the OES Message 
Store and displayed in the eMC AG

■ The agent can read the message and choose to:

■ Respond to the message

■ Cancel immediate processing of the message (put it off until later)

■ Reroute the email

■ Forward the email

■ Transfer the email
Implementing Oracle eMail Center 13
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16. On the agent interface, eMC AG displays customer data, made available from 
the business application by the UWQ Client.

■ eMC AG displays the customer data in its Customer Profile area.

■ TeleService Contact Center is an example of a business application.

■ UWQ Client delivers the screen pop to the business application form being 
displayed on the agent interface (see 15A).

■ The business application form sends appropriate data to eMC AG for display.

17. The agent selects the ‘Respond’ option in the eMC AG ‘Preview’ screen and the 
‘Response screen is displayed.

■ Other metadata for the message retrieved from the database and displayed in 
the various eMC AG screens includes:

■ Suggested classifications

■ Suggested responses

■ Marked up message information

18. JSP / JTF components interpret actions taken in the eMC Agent GUI and makes 
the appropriate API calls in response to these requests to perform the desired 
actions.

19. Create and send the agent generated response.

■ The agent constructs the response in the editor by typing in the response and / 
or picking up suggested responses or response documents and attachments 
from the knowledge base or file system.

■ The response is composed and formatted by the JSP / JTF servlets on the web 
server.

■ The outbound email is delivered to the outbound message queue in the OES    
message store using java mail API (JMA) calls.

20. The outbound email is picked up from the queue and sent to the Internet via the 
sendmail process.

Note: Only the Respond option is used as an example.
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eMail Center Processes

Overview
eMail Center has three processes:

1. Inbound Server Processing.

■ Structured eMail Processing

■ Unstructured eMail Processing

2. Desktop Processing.

3. Outbound Server Processing.

■ Single Message

■ Bulk Mailing

Inbound Server Processing
Inbound processing begins when the eMail Server receives a customer message and 
passes it to the eMail Center Server.
Implementing Oracle eMail Center 15
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Customer
The customer creates an email message.

Message arrives at Oracle eMail Server

The server must be Oracle eMail Server.

Is email of type structured?

Email type can be either structured or unstructured. Structured email comes from a 
form the customer filled in on a web site or from a customer reply to an email 
questionnaire that had a structured format. In the case of a reply, the customer must 
be instructed to keep the email ID included in the original message and to answer 
the form without modifying its format.

If the email is type structured, go to Structured Message Processing

If the email is type unstructured, go to Unstructured Message Processing

Structured Message Processing
If the email is type structured, the process takes this path.

Execute structured workflow

eMail Center has one workflow, and it includes a structured path. The structured 
workflow path has several process paths available that are parallel to each other. 
The workflow process selects one of them.

Decode structured ID tag

The inbound structured email message contains an ID tag that identifies what 
structured email template it uses.

Invoke business application sub-workflow based on value of tag

eMail Center processes the email and selects the appropriate workflow based on 
specifications in the structured email. It might execute Fulfillment functions, then it 
can launch an Oracle business application, such as Customer Care.

Send automated response

(See outbound processing.) Whether or not eMail Center executes Fulfillment 
functions or launches a business application, it is capable of generating an 
automatic email response to the customer.

Unstructured Message Processing
If the email is type unstructured, the process takes this path.
Implementing Oracle eMail Center 17
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Extract message header information

Read the header information associated with the email. It includes the sender’s 
return address and the subject line.

Apply linguistic processing on message body & readable attachment contents

Extract readable attachments and concatenate their text to the email body. Using 
linguistic processing, generate themes for the concatenated message.

Generate classifications

Analyze the themes, comparing them to classification theme signatures in the 
classification table. Select the top classification matches.

Select suggested responses from the knowledge base for each classification

Suggest responses for the top classification matches. Do this by using a mix of the 
theme signatures identified in the email and theme signatures of the top 
classification matches. With the theme signature mix, get suggested responses from 
the knowledge bases, MES and SMS.

Is top classification score greater than the auto-response classification threshold?

If the classification score inspires confidence, then go to the next test.

If the classification score does not inspire confidence, route the message to an agent. 
Go to Route message to appropriate agents.

Is the associated top suggested response score greater than the auto-response 
response selection threshold?

If the response score inspires confidence, send the response. Go to Send automated 
response (see outbound processing).

Route message to appropriate agents

If either the classification score or the suggested response score do not inspire 
confidence -- were not greater than the respective threshold -- send the message to 
an agent for handling.

Send automated response (see outbound processing)
If both the classification score and the suggested response score do inspire 
confidence, send the response if auto-response is not turned off. It does not require 
agent intervention.
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Desktop Processing
Desktop processing begins the first time when the agent requests an email work 
item in the Universal Work Queue (UWQ). It repeats itself each time the agent 
requests another email item.

The desktop process can handle either inbound email or outbound email. Inbound 
email normally is unstructured. Structured email does not require agent 
intervention unless the template is missing or an error occurs. The only outbound 
email the agent handles is that which the agent initiated manually. Outbound email 
generated by a business application does not require agent intervention.
Implementing Oracle eMail Center 19
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Agent Interface
In an interaction center, agents can be assigned to multiple communications media, 
including inbound telephone calls, outbound telephone calls, and email. In this 
scenario, either the supervisor, the agent, or Oracle Interaction Blending indicate 
that the agent is working with email. 

The agent begins working with email by requesting an email item from the 
Universal Work Queue.

At the end of the each email item the Desktop Processing loop returns to this point 
and presents the agent with two options:

■ Agent requests next email work item in Universal Work Queue

■ Agent views folders / messages screen in the eMC (eMail Center) Application

Agent requests next email work item in Universal Work Queue
The agent begins one email cycle by requesting an email item from the UWQ.

Is the previous interaction ended in the business application?

Normally the agent handles only one customer interaction at a time. If Customer 
Care or some other business application still has an open interaction, it must close 
the interaction before UWQ will issue an email item to the agent.

Select message in folder

If no interaction is open, then the agent can select a message from one of the folders.

Email and associated meta data delivered to eMC application and business 
application

eMail Center releases an email item to the agent. This includes the meta data, which 
is message header information and other properties.

Business application "popped" with customer information

If the agent is in a business application, such as Oracle Customer Care, eMail Center 
sends the message to that application. The message meta data frequently contains 
enough information for the business application to find the customer’s record -- 
assuming an existing customer -- and pops it on the screen.

Agent views the preview screen

The agent can preview the message before responding to it by clicking the subject of 
the message in the inbox. At this point, the agent is looking at a preview of the 
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email message, and has not taken any action on it. The agent could cancel the 
preview and request another email item.

The agent has several options to choose amongst that include:

■ Forward email

Forward the email outside eMail Center or outside the interaction center.

■ Transfer email

Transfer the email to another agent handling the same account. For example, an 
agent assigned to the "Support" account can only transfer emails to other agents 
handling the "Support" account.

■ Reroute email

Reroute the email to another agent queue. This might indicate that the 
workflow has an error in its agent group routing.

■ Print email

Print the email and return to the preview.

■ Delete email

Delete the email and return the agent to a display of email folders and message 
screens. Go to Agent views folders / messages screen in the eMC Application.

■ Cancel preview

Cancel the preview without taking any action. Return the agent to a display of 
email folders and message screens. Go to Agent views folders / messages 
screen in the eMC Application

■ Respond

Take action on the email. Go to Agent selects Respond and views the eMC 
response screen.

Agent selects Respond and views the eMC response screen

In choosing to respond to the email, the agent has several choices, including:

■ Accept the suggested classification and response. This leads to three nodes in 
the process flow:

■ Select Classification

■ Select suggested response

■ Insert/Attach suggested response
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These steps are self explanatory. The agent can repeat them several times 
for each issue marked up in a multi-issue email, and for as many 
classifications and responses as are available in the suggestion lists.

■ Attach desktop document

■ Customize the response

■ The agent can customize the response by typing free form text using the 
full-featured editor available. The agent may also wish to respond to the 
message manually rather than use a suggested response. In this case the 
agent either type the message or can select a "template" from the standard 
set of templates available. 

■ Search KB (knowledge base) and attach / insert KB document

These three options, Attach, Type, and Search, also are self explanatory. They 
present three options in the process flow as well:

■ Edit email headers (subject, addresses) and select ’Send’

When the agent selects Send, the email is sent to the node labeled, To 
Outbound Server Processing

■ Select ’Cooperate’ and send transfer mail and partial response to another 
agent

■ Save message

On completing each of these three options, Edit, Cooperate, or Save, the 
process flow takes the agent to the node, End interaction in business flow.

End interaction in business application

This is the end of one email item process cycle. The agent starts another cycle in one 
of the first nodes: 

■ Agent views folders / messages screen in the eMC Application

■ Agent requests next email work item in Universal Work Queue

Agent views folders / messages screen in the eMC Application
This is an alternate point for the agent to begin an email cycle, the first being Agent 
requests next email work item in Universal Work Queue. 

If the agent chooses this path, the Desktop Process offers these options:

■ Select message in folder
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■ Select email history tab and view email history

■ Select knowledge base (KB) tab to navigate and search the KB

■ Add email folder

■ Delete email folder

■ Refresh

■ Acquire new emails

■ Select All 

■ Deselect All

■ Move emails between subfolders

■ Compose new message

These options are self explanatory. When the selected option is completed, the 
Desktop Process returns the agent to this node.

One of the options, Compose new message, takes the agent though several 
process nodes before returning to this node.

Select Message in folder

This entry in the description is repeating an option of its parent node. It is needed to 
continue describing the process of this node.

If the agent selects a message in the folder, Desktop Processing routes the agent to 
the same flow path described earlier: 

■ Go to the first node, labeled Agent requests next email work item in Universal 
Work Queue, and 

■ Look at the next step in the Desktop Processing, labeled Is the previous 
interaction ended in the business application? The process follows that path.

Compose new message

This entry in the description is repeating an option of its parent node. It is needed to 
continue describing the process of this node.

If the agent chooses to compose a new message, Desktop Processing offers these 
options (they are similar to, but slightly different from, the options offered by the 
Agent selects Respond and views the eMC response screen node):

■ Attach desktop document

■ Type response text
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When selecting to respond manually, the agent has two options not shown in 
the process flow:

■ Respond to messages manually, typing free form text

■ Respond to messages using a response template. Here the agent manually 
selects a template category. Then the Merge screen appears with a list of 
suggested responses under the selected template category.

■ Search KB (knowledge base) and attach / insert KB document

These three options, Attach, Type, and Search, also are self explanatory. They 
present three options in the process flow as well:

■ Edit email headers (subject, addresses) and select ’Send’

When the agent selects Send, the email is sent to the node labeled, To 
Outbound Server Processing

■ Select ’Cooperate’ and send transfer mail and partial response to another 
agent

■ Save message

On completing each of these three options, Edit, Cooperate, or Save, the 
process flow takes the agent to the node, End interaction in business flow.

End interaction in business application

This is the end of one email item process cycle. The agent starts another cycle in one 
of the first nodes: 

■ Agent views folders / messages screen in the eMC Application

■ Agent requests next email work item in Universal Work Queue

To Outbound Server Processing
This node points to the Outbound Server Processing flow chart.

Outbound Server Processing
Outbound Processing can begin one of three ways: 

■ It can begin when a business application, such as Customer Care, starts a bulk 
mailing campaign. 

■ In that same business application, an agent or a process can create a single email 
message, also causing Outbound Processing to begin.
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■ Earlier in this document, Desktop Processing caused Outbound Processing to 
begin when an agent selected the Send option either while responding to an 
inbound email or while creating a new email.

The Outbound Process has a single path with two entry points:

■ Business application creates a mailing list

The business application is executing a bulk mailing campaign.

■ Application sends outbound request to eMC (eMail Center server)

The business application is sending a single message.

This description starts at the beginning of the Outbound Processing path and 
continues to the end.

Business Application
A business application, such as Fulfillment, starts an automated process and creates 
a single campaign.
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Single Message
This is the second entry point. In the business application an agent or a process 
created an email message.

Application sends outbound request to eMC

Obviously the single message is inserted here.

Send Response
Send Response is a group of nodes in the eMail Center process that generates a 
message to be sent to the eMail Server on its way to the customer.

The group of Send Response nodes are:

■ Select message template

■ Expand personalization / merge fields

■ Populate header information

Header information includes the customer’s email address in the To field and a 
title for the Subject field.

■ Send message

The eMail Center Server sends the message to the eMail Server.

Planning the Implementation
Implementing Oracle eMail Center is a complex process that requires knowledge of 
a variety of technologies and processes. Persons implementing Oracle eMail Center 
should have a working knowledge of Oracle Forms, HTML, Java, and the 
installation platform (Windows NT or Unix), in addition to an understanding of the 
operational requirements of an interaction center.

This topic group contains an implementation planning questionnaire that will help 
you determine and collect information you will need during the implementation 
process.

The Implementation Process
The following diagram depicts the implementation process for eMail Center:
Implementing Oracle eMail Center 27



Planning the Implementation
Implementation Planning Questionnaire
The following questions provide a high level overview of the information necessary 
to successfully implement Oracle eMail Center. This is information that should be 
decided upon prior to beginning the implementation process.
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Use the following questionnaire to gather information crucial to the implementation 
process:

1. What email addresses does the business want to set up to receive email?

You will need to define the corresponding email accounts on OES to which 
inbound email will be directed. Examples could be: support@company.com, 
info@company.com, promotions@company.com, sales@company.com, etc.

2. For each email account to be defined, which agents will be processing 
interactions?

Note: An agent may be defined for multiple accounts, e.g., if an agent needs to 
work on email interactions sent to the ‘support’ account as well as those sent to 
the ‘info’ account.

3. How will agents be grouped for each account?

Is it sufficient to define only one group for all the agents assigned to a particular 
account, or does it make sense to divide the agents into groups?

It would make sense to define multiple agent groups for a particular account if 
there will be different agents who focus on working on certain types of issues / 
classifications for the account, so that routing rules can be set up appropriately.

4. For each account, what’s the set of classifications that need to be defined?

These classifications are essentially labels for the buckets into which the 
customer wants to sort incoming emails for a particular account. Classifications 
can be used to route individual emails to agents as well as select the appropriate 
responses from the knowledge base. The subject matter for each classification 
should be mutually exclusive and collectively exhaustive for emails expected to 
be received in that account. 

5. What are good sample messages for each classification?

■ Does the customer already have sample data?

■ Do you need to create samples for classifications?

Note: Setting up multiple groups for a given account does not 
mean that you cannot route a given interaction to multiple groups. 
Defining multiple groups provides additional granularity for 
routing purposes.
Implementing Oracle eMail Center 29



Planning the Implementation
■ Do the samples completely represent the different subject matter 
anticipated in emails belonging to the classification?

6. What are good sample responses for each classification?

■ Does the customer already have sample data?

■ Do you need to create samples for classifications?

■ Do the samples completely represent the different types of responses for the 
classification?

 Ideally, there should be at least one sample response for each sample message. 
As is the case with sample messages, the quality of the sample responses 
directly impacts the effectiveness of the response selection functionality and 
should only contain text that is directly relevant to the response subject matter.

7. What documents need to be uploaded to the knowledge bases? 

8. What static routing rules need to be defined?

What should be the destination agents / agent groups for each static route?

9. What dynamic routing procedures / workflows need to be developed?

What are the implementation details for creating the stored procedures / 
workflows?

10. What keywords or key phrases in the headers or contents of a message indicate 
which eMC account a message belongs to?

E.g., a message with the key phrase ‘service request’ belongs in the ‘support’ 
account, and if it was sent to the ‘info@company.com’ account it should be 
redirected to ‘support@company.com’.

11. What are the business requirements for processing unstructured emails?

■ What are the rules for determining when to send an auto-acknowledgement 
and selecting the response for the auto-acknowledgement?

Note: The quality of the sample messages directly impacts the 
effectiveness of the classification functionality. Sample messages 
should only contain text that is directly relevant to the subject 
matter for that classification (the text can be regular sentences as 
opposed to a list of keywords, but should not contain text such as 
‘Thank you in advance for your prompt attention to this matter,’ or 
other extraneous text).
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■ What information from the CRM DB needs to be extracted to make 
processing decisions for an email message?

■ What information should the system look for in the incoming message to 
use in rules processing?

■ And so on...

12. How should bounced messages and other responses to tagged emails be 
handled?

■ Responses routed directly to the agent who sent out the message, or routed 
according to the routing server rules?

13. Notify sending application on message bounce / auto-response?

14. What are the default outbound email header values for each account?

From address, reply-to address, etc.

15. What are the processes / transactions that are or should be targeted for 
automated processing using structured email?

As a general rule, you should try to structured email processing enable high 
frequency interactions / transactions for which automated processing is 
possible, using workflows that can access customer data, knowledge base 
documents, and CRM / ERP functionality to generate appropriate responses.

16. For each business process / interaction that needs to be structured email 
enabled, what are the requirements for the associated HTML (Web) form?

■ What input do you need from web users to automate the targeted business 
process / interaction?

■ What additional information do you want to get from the web user?

■ What information do you need / want to provide to the web user when he 
/ she is filling in the form?

■ What should the layout of the HTML form look like?

■ Do you want to embed javascript or equivalent code to do input validity 
checking?

■ What are the valid values for each input field?

■ Which fields are required versus optional?

17. For each structured email HTML form, which previously defined eMC account 
should the form be sent to?
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18. For each business process / interaction that needs to be structured email 
enabled, what are the requirements for the associated workflow?

■ What does the associated workflow need to do?

■ What are the required workflow nodes?

■ Which ones are already available, which need to be built? 

19. For each business process / interaction that needs to be structured email 
enabled, what should the response template look like?

What merge fields will be included in the response template?

Integration Dependencies
This topic group contains a list of the core products with which Oracle eMail Center 
integrates and a brief description or each core product.

Oracle Email Server (OES)
Oracle Email Server is the core email system. The native email functionality is 
supported by this system. Oracle Email Server has both PL/SQL and IMAP 
interfaces and is bundled with the Sendmail implementation of SMTP service.

The topics in this section describe its important sub-components.

IMAP server
Oracle Email Server implements the server section of the IMAP protocol. The server 
is mainly used by the IMAP implementation of JMA (middle tier) to access emails 
stored in the Message Store.

Message Store
The Message Store resides in an Oracle database (8.1.6), and it is a collection of 
database tables and stored procedures that implement the various email specific 
operations. Email accounts including folders, all incoming emails, and all outgoing 
emails are stored here.

SMTP Server
Currently Oracle Email Server is bundled with the Sendmail’s implementation of 
the SMTP protocol. Various options like third party spam and virus checks can be 
added to make a more robust system.
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OES PL/SQL APIs
The Oracle Email Server PL/SQL APIs extend the normal email functionality to 
implement rule based notifications, account maintenance, and interMedia Text 
(iMT) processing of incoming email messages. This additional functionality results 
in a close integration with the Oracle Email Server product.

Known Limitations:
■ Oracle eMail Center is tightly integrated with this product. Other Email 

Services, existing or new, must integrate with this product.

■ Spam and Virus check features are currently missing.

■ Email encryption/decryption features are missing in the Oracle Email Server 
release 5.1.x.

■ Oracle interMedia Text’s linguistic processing currently work only on English 
text. Other languages are being supported in the future releases.

Platform Dependencies:
■ Oracle Email Server and its components are ported to most major platforms.

Configuration Options:
■ Oracle eMail Center can integrate to multiple instances of Oracle Email Server. 

In some cases there will be multiple instances of Oracle Email Server Message 
store, which share a common IMAP server and SMTP components.

Oracle interMediaText (iMT)
Oracle interMedia Text is a text/linguistic-processing module bundled as a 
component of Oracle 8.x database. It is mainly used to determine the intent of each 
incoming email message.

Known Limitations
■ Oracle interMedia Text’s linguistic processing currently work only on English 

text. Other languages are being supported in the future releases.

■ Only bundled with Oracle 8 and higher versions. Not available on earlier 
versions.

Platform Dependencies
■ Ported to most major platforms.
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Configuration Options
■ You can customize the linguistic processing module by modifying the theme 

and iMT Knowledge Base sections. This focuses the linguistic processor to look 
for more relevant information and enables you to fine-tune email processing.

Oracle Telephony Manager (OTM)
The Oracle Telephony Manager maintains the agent distribution queues and agent 
states for any Interaction Center. It also provides access to a common routing 
engine. OTM is media independent and can route all types of interactions (email, 
telephony, faxes, web calls) to the call center agents.

Known Limitations
■ Only one OTM server can exist per Interaction Center.

Platform Dependencies
■ A Java Server; Runs on Solaris and NT platforms.

Configuration Options
■ There is a 1:1 relationship between an OTM and an eMC Server; however, the 

rest of the eMail Center modules are shared.

Routing Server
The Routing Server determines which agent(s)/agent groups get a new interaction. 
The routing can be skill and/or rule based. The routes are defined for various 
classifications and parameters.

Platform Dependencies
■ A Java Server; Runs on Solaris and NT platforms.

Work Blending
The Work Blending server determines the type (email, phone call, fax, etc.) of 
interaction an agent should service next. To make this determination, Work 
Blending obtains real time information about the agent from UWQ.
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Universal Work Queue
UWQ Client and Server code work in unison to do the following:

1. Relay information between OTM and the Forms Application.

2. Capture certain information for statistical purposes.

3. Capture certain information for work blending purposes.

UWQ also works in conjunction with Work Blending to determine what type of 
interaction the agent should service next.

Platform Dependencies
■ A Java Server; Runs on Solaris and NT platforms.

Interaction History (IH)
The Interaction History maintains all interaction life-cycle segments, i.e. accounts 
for the entire time duration beginning at the moment an Interaction (fax, phone call, 
email.) is registered in the system to the instant it is resolved. This is a cumulative 
record of all interactions passing through the system. It also records information 
about various agents who handled the interaction in the recorded time duration.

Forms Business Application
This can be any Oracle CRM Forms application (Oracle Service, Oracle TeleSales, 
Customer Care). These forms applications embed the UWQ client, enabling them to 
work with the Oracle eMail Center agent interface. This is done via Java socket 
communication between the UWQ client and the eMC agent interface. The business 
applications contain the necessary profiles and business intelligence.

Fulfillment Server
Fulfillment Server is a part of Oracle CRM Foundation. This service enables various 
applications to fulfill/complete various pending tasks. For eMail Center, this service 
enables eMC to automatically send out single and/or bulk emails.

Knowledge Management Systems (KMS)
At present, the Knowledge Management system consists of SMS and MES. All KMS 
interactions are channeled through the SMS system which exposes a single set of 
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APIs hiding the complexity of the various sub-systems. Both PL/SQL and Java APIs 
exist to enable interMedia based queries and retrievals.

Both MES and SMS are knowledge bases. eMail Center uses MES to store eMC 
specific documents. SMS is currently optional for eMail Center. At present, eMail 
Center does not support automated responses using information from the SMS 
knowledge base.

Solution Management System (SMS)
A repository of problem, diagnosis, related symptoms and their solutions.

Marketing Encyclopedia Systems (MES/KB)
MES is also known as the Knowledge Base (KB). It is a repository of various 
documents, URL, images and such. MES is partitioned into various application 
spaces, each application (e.g Tele-Sales, Oracle eMC, etc.) can store documents, 
URLs, images and such in its own private space in this system. Various PL/SQL 
and Java APIs and a JSP UI exists to create/upload, list, categorize and order these 
entities.

Platform Dependencies
■ A database module; Oracle 8.x ported to most platforms.

Concurrent Manager
Concurrent Manager is a component of Oracle Application Object Library. It is 
responsible for scheduling and running various concurrent programs submitted by 
the user. It uses Distributed Concurrent Processing and can simultaneously run 
concurrent requests on several different server machines or CPUs. Oracle eMail 
Center makes use of this facility to schedule and run various email processing 
modules.

Platform Dependencies
■ A database module; Oracle 8.x ported to most platforms.

Installation
 This topic group covers the following topics:

■ Pre-installation steps
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■ Installation by Rapid Install

■ Post-installation steps

Pre-Installation Steps
There are currently no pre-installation steps necessary for either the agent interface 
or eMail Center Server for Oracle eMail Center.

The Auto-Installation Process
This topic provides a high level overview of the auto-installer (Rapid Install) 
process. This process installs the schema and core functionality (Foundation 
Components) for Oracle applications. There are five steps in the process, as well as 
some finishing steps that need to be performed to successfully complete the 
installation process.

Steps
1. Choose the desired install environment (production, test, or demo).

2. Select the products to install.

3. Select the NLS settings.

4. Select the location of the top-level directories.

5. Select the name of the configuration file.

6. Complete the finishing steps necessary for the products you selected to install.

References
For more detailed information on the Rapid Install process, please refer to the How 
Rapid Install Works topic group in the Installation Overview section, and the 
Running Rapid Install topic group in the Starting Your Installation section of the 
Oracle Applications Installing Oracle Applications documentation.

Post-Installation Steps
Two post-installation procedures are necessary for the eMail Center server side. The 
first procedure consists of installing and configuring the Email Server. The second 
procedure involves installing and configuring the eMC Server. For the second 
process, you will need the Oracle Call Center Applications Setup CD.

Installing and Configuring Oracle Email Server (OES)
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Installing and Configuring Oracle eMail Center Server (eMC)

Installing and Configuring Oracle Email Server (OES)
Use this procedure to install and configure Oracle Email Server.

Prerequisites
Before configuring the Email Server, you should complete the initial Rapid Install 
process. The Oracle Email Server documentation provides detailed instructions on 
installing Email Server with Rapid Install.

Steps
1. Install Oracle Email Server (OES) 5.1 (patchset 3) on the same or on a separate 

instance as the Oracle Applications Instance. Follow the instructions provided 
in the Oracle Email Server Installation Guide (Installing Oracle Email Server 
section). Oracle Email Server was formerly known as Oracle Internet Messaging 
(IM).

In the post-install Email Server configuration, select NO for LDAP install. For 
more information on this step, refer to the Oracle Email Server Installation Guide 
(Configuring Oracle Email Server section).

Once the installation process is complete, you can configure the Oracle Email 
Server instance to talk with the Oracle Applications Instance.

2. Connect to the Oracle Email Server database instance with the OO user and 
password. Grant privilege on IM_IMT_EXTN to oraoffice.

3. Create a sqlnet tnsnames entry on the Oracle Email Server machine to point to 
the Oracle Applications Instance. (If installed on an instance separate from 
Oracle Applications Instance).

4. Create a Database Link to the CRM instance from the Oracle Email Server 
instance. You need the following:

■  Password for the Oracle Applications APPS schema.

■  Password for the Oracle Email Server OO schema.

Note: The default configuration is single instance. Single instance 
implies that Oracle Applications data and Oracle Email Server data 
reside in the same database.
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Use SQLPLUS to login to Oracle Email Server as user OO (using the OO 
password entered during Oracle Email Server installation) and use the 
following to create the database link:

CREATE DATABASE LINK <link name> CONNECT TO <APPS 
username> IDENTIFIED BY <APPS password> USING <tns / service 
name>;

Installing and Configuring Oracle eMail Center Server (eMC)
Use this procedure to install and configure Oracle eMail Center Server (eMC 
Server).

Overview
eMC Server is installed as part of the Call Center Applications installation process.

Prerequisites
Before you can create an eMC Server, you must create a Server Group for the eMC 
Server.

Perform the following steps to create a server group:

Note: The name of the above mentioned database link <link 
name> is used later to configure other eMC components.

Note: Oracle eMail Center follows the Oracle standard for User 
Interfaces and the following field colors indicate:

Yellow - required field

White - optional field

Grey - read only field

Light blue - query mode

Note: The server group you create here will be referenced in the 
Create Account screen as an Interaction Center.
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1. Open the Server Administration module from the Front Office Navigator, 
the Call Center Administration module, or the Routing Server 
Administration module.

The Server Locator Window opens at the Server Group tab screen.

2. In the Server Group Registration area, enter the server Group Name, 
Location, and Description.

3. From the File menu, choose Save.

Steps
1. From the Self Service application login screen, login using the default system 

administrator user name and password.

2. From the list of application responsibilities, select Call Center Server 
Administration.

The Call Center Server Administration module appears.

3. From the Call Center Server Administration module, double-click UWQ Server 
Locator (if it doesn’t open automatically).

The Server Locator screen appears.

4. From the Server Locator screen, click the Server tab.

5. In the Server Registration area, type data for the following fields:

■ Server Name

■ Server Location

■ Type Name - select iCenter Server from the drop-down list, click OK

■ Member Group Name - select the server group you want this server to 
belong to, click OK

■ Using Group Name - select the using group ID from the drop-down list, 
click OK This identifies other groups that have permission to use this 
server.

■ User Address - optional field, enter information if you wish

Note: DNS Name and IP Address will be automatically assigned 
after the eMC Server is run for the first time.
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■ Description - optional field, enter information if you wish

■ Server Parameter - not required for configuring eMC Server

■ Value - not required for configuring eMC Server

6. From the File menu, click Save.

References
For detailed information on installing eMC Server, please refer to the Oracle Call 
Center Applications Setup documentation.

Refer to the Oracle Telephony Manager Concepts and Procedures documentation for 
detailed information on creating a server group.

Implementation
This topic provides a high level overview of the implementation process. This 
section is designed to furnish you with an overall idea of the order in which the 
implementation of Oracle eMail Center occurs. Each of the steps will be expanded 
upon in individual topics.

Prerequisites
The installation process must be completed before you can begin implementing 
eMail Center.

Steps
1. Create Email Accounts on the Email Server

2. Create User Accounts

3. Define Email Server Accounts

4. Creating an eMail Center Agent

5. Setting up Routing for Inbound Email.

6. Configure eMail Center Properties

7. Configure UWQ to Launch the Business Application

8. Create Classifications and Themes

9. Configure Structured Email Templates

10. Configure Automated Response Documents and Associated Queries
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11. Upload Suggested Response Documents

12. Use Email Processing Workflow

Creating Email Accounts on the Email Server
For detailed information about creating email accounts on the Email Server, refer to 
the Managing Directory Information chapter of the Oracle Email Server 
Administration documentation (Creating Email Server User Accounts section).

Creating User Accounts
Oracle eMail Center System Administrator Interface ships with four default 
responsibilities, eMail Center Administrator, eMail Center Operations Manager, 
eMail Center DBA, and eMail Center Client. The process of setting up an 
Administrator or Operations Manager and assigning the appropriate 
responsibilities consists of several steps.

1. Creating an employee (forms app)

2. Creating a CRM user (HTML app)

3. Assigning user responsibilities (forms app)

4. Setting JTF default profiles (forms app)

5. Setting UWQ Default Profiles (forms app)

6. Setting CRM resources (forms app)

Note: You should have administrator level access to both the 
forms and the HTML based applications to perform these tasks.

Step: 1 2 3 4 5 6

Admin X X X X

Ops. Manager X Xt X X X

DBA X X X

Agent X X X X X Xtt
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t You need to assign JTF_ADMIN role
tt You cannot perform this step until the OES accounts are defined in eMail 
Center

Creating an Employee with HRMS
Use this procedure to create employees with the Oracle Human Resources 
Management System.

Prerequisites
To perform the following steps, you must have Oracle HRMS installed and 
configured. If you do not have Oracle Human Resources Management System 
installed, you will need to create the employee using the Oracle Resource Manager 
application.

Steps
1. From the Self-Service (forms) application login screen, login using the default 

system administrator user name and password.

2. From the list of application responsibilities, select US HRMS Manager.

The Navigator-HRMS Manager screen appears, displaying a list of functions.

3. From the list of functions, double-click People.

4. Double-click Enter and Maintain.

A decision box appears, asking you if you want to change the effective date.

5. Click NO.

The Find Person screen appears.

Note: You cannot create the agent account at this time. You must 
first define the email server accounts as shown in the Defining 
Email Server Accounts topic. Once you have defined the email 
server accounts, you can then create the agent accounts by 
following steps 1-6 above.

Note: If the employee already exists, you do not need to perform 
this step.
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6. From the Find Person window, click New.

An employee data form appears.

7. On the form, type information in the following fields:

■ Last - (name)

■ First - (name)

■ Title - (select from the drop-down list)

■ Type - (select from the drop-down field)

■ Employee Number

■ Birth Date

■ Social Security Number (for US version only)

■ All other fields are optional

8. Save the record to complete the process of creating an employee.

References
For more information and detailed steps on creating employees, refer to the Oracle 
Human Resources System Administration documentation.

Creating a CRM User
Use this procedure to create CRM users.

Steps
1. From the common CRM login screen, type the default system administrator 

user name and password.

The CRM default screen appears.

2. Click the User tab.

3. Click the Add sub-tab.

The User Registration screen appears.

4. On the User Registration screen, enter data for all required fields.

Note: Do not exit the application at this time. You will be 
returning to it when you assign user responsibilities.
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■ Select "End User" from the Account Type drop-down list

5. Click Submit.

6. Click the Assign Roles sub-tab.

The Search User screen appears.

7. On the Search User screen, type the user name and click Go!.

The User Name table appears.

8. From the list of names, click the desired user name.

The User - Role Mapping table appears

9. Select the JTF_FM_ADMIN role (this role allows integration with the 
Fulfillment console).

10. Click ">" to assign the above role to the user.

11. Click Update.

Assigning User Responsibilities
Use this procedure to link the user to the employee and to assign user 
responsibilities.

Note: Perform the following steps for creating the Operations 
Manager account ONLY.

Note: You can search all user names by performing a wildcard 
search instead of typing the full user name.

Note: Do not exit the application once you select roles!
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Steps
1. From the Self Service application login screen, login using the default system 

administrator user name and password.

2. From the list of application responsibilities, select the System Administrator 
responsibility.

The Navigator System Administrator screen appears, displaying a list of 
functions.

3. From the list of functions, click Security, User, then Define.

The User form appears.

4. Query each type of user and assign the appropriate responsibility to that user.

5. From the drop-down list in the Person field, select the name of the 
corresponding employee previously created in the Creating an Employee section.

Note: If you are already logged into the Oracle Forms application, 
click File, select Switch Responsibility, and select System 
Administrator. Otherwise, follow steps 1 and 2.

User Type Responsibility

Administrator eMail Center Administrator

Operations Manager eMail Center Operations Manager

DBA eMail Center DBA

Agent eMail Center Client (agent interface)

Note: If you want the agent to be able to handle telephone calls, 
then select Interaction Center Agent as the responsibility.

Note: You can search all user names by performing a wildcard 
search instead of typing the full user name.
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6. From the File menu, click Save.

References
For more information on setting up the UWQ Selector and selecting agent work, 
refer to the Oracle Universal Work Queue Concepts and Procedures and UWQ Selector 
GUI documentation.

For more information on creating users, refer to the Oracle Human Resources 
Management System (HRMS) documentation.

Setting JTF Default Profiles
Use this procedure to set JTF default profiles.

Prerequisites 
You must know the responsibility ID for eMail Center Administrator, Operations 
Manager and Agent before setting the JTF profile. To find the responsibility ID, 
perform the following steps:

1. From the Navigator System Administrator screen, click Security, 
Responsibility, then Define.

2. Query the desired responsibility based on the table below:

3. From the Help menu, click Diagnostics, then Examine....

The Examine Field and Variable Values screen appears.

4. Click the drop-down list in Field.

Note: Oracle recommends that only one user is assigned to each 
employee. It is possible, however, to assign multiple user IDs to an 
employee, even though you will receive warning messages.

User Type Responsibility

Administrator eMail Center Administrator

Operations Manager eMail Center Operations Manager

Agent eMail Center Client (agent interface)
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The Choose a Field screen appears.

5. From the list in the Choose a Field screen, select the RESPONSIBILITY_ID.

6. Click OK.

The value of the RESPONSIBILITY_ID is displayed in the Value Field of the 
Examine Field and Variable Value screen.

7. Click OK.

Steps
1. From the Navigator System Administrator screen, click Profile, then System.

The Find System Profile Values screen appears.

2. From the Find System Profile Values screen, click Clear.

3. Click the User check box and from the drop-down list in the User field, select 
the user name.

4. In the Profile field, type %JTF_PROFILE_DEFAULT% and click Find.

A list of system profile values appears.

5. In the User column, set the following values for these profiles:

Note: Repeat these steps for the Administrator, Operations 
Manager, and Client responsibilities.

Profile Value Description

JTF_PROFILE_DEFAULT_
APPLICATION

680 eMail Center value for the 
application ID.

JTF_PROFILE_DEFAULT_
LANG

US This is the language code. (It is 
possible that you may not have this 
profile. If this is the case, your 
language setting is controlled by the 
ICX: Language profile).

JTF_PROFILE_DEFAULT_
NUM_ROLES

15

(recommended)

This determines the number of 
rows you can see on each page 
when in browse mode.

JTF_PROFILE_DEFAULT_
RESPONSIBILITY

This is the value responsibility ID 
you obtained in the prerequisite 
steps.
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6. From the File menu, click Save.

7. Repeat these steps for every user with the Administrator or Operations 
Manager responsibility.

Setting UWQ Profiles
Setting the following UWQ profiles controls the kind of work (telephone calls, 
email, etc.) that is queued for an agent.

UWQ profiles only need to be set for agent accounts. Use this procedure to set 
UWQ profiles.

Steps
1. From the Profile screen, type%IEU% in the Find field (this will search all 

profiles that start with IEU).

2. Click OK.

A list of profiles appears.

3. From the list of profiles, select IEU: Queue: Inbound Email.

4. Click OK.

The Inbound Email Profile appears in the System Profile Values screen.

5. From the drop-down list in the User field, select YES.

6. Save the record.

7. Repeat steps3 through 6, selecting profiles for IEU: Queue: Email and IEU: 
Blending Style.

8. Save the record to complete the process of setting up UWQ profiles for the new 
agent.

Note: The profile must be selected for the site level before 
selecting it for the agent level.

Note: For the IEU: Blending Style profile, select Not Blended 
from the drop-down list in the User field.
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Setting CRM Resources
These steps should only be performed to set CRM Resources for users with the 
Operations Manager and Agent responsibility.

Use this procedure to set the CRM resources.

Steps
1. From the Navigator System Administrator screen, click File, then Switch 

Responsibility.

2. Select the CRM Administrator responsibility.

A screen appears, displaying a list of functions.

3. From the list of functions, double-click the Resources Manager.

4. Double-click Maintain Resources.

5. Double-click Import Resources.

The Selection Criteria screen appears.

6. From the Resource Category field, select Employee.

7. From the Name field, select the new employee’s name.

8. Click Search.

The Search Results list appears, displaying a row of data with Category set to 
Employee and Name set to the new employee’s name.

9. Click Create Resource.

The Default Values screen appears.

10. Click OK.

The Selected Resource screen appears.

11. From the Selected Resources screen, click Save Resource.

12. Click Detail.

The Resource screen appears.

13. Perform the following steps depending on the account type:

For Operations Manager account(s):
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■ In the Roles tab, select Marketing Encyclopedia from the drop-down list 
for Role Type and select MES Administrator from the drop-down list for 
Roles (this allows integration with the MES application).

For Agent account(s)

■ In the Interaction Center tab, select the desired interaction center you wish 
to associate with the eMail Center from the drop-down list in the 
Interaction Center field. From the drop-down list in the Email Account 
field, select the desired email account. Select Default from the drop-down 
list for the Parameter field and click the Value field to select the default 
values.

14. Accept the default values on the remaining tabs.

15. From the File menu, click Save to save the resource.

Defining Email Server Accounts
This topic group provides a high-level overview of the steps necessary to define 
Email Server accounts in the eMail Center System Administrator Interface, a 
worksheet for gathering all the necessary information, and detailed steps for 
performing each part of the defining Email Server accounts procedure.

High-level Steps

Prerequisites
To perform the following steps, you must have an administrator level status.

Steps
1. Create a Server Group entry.

2. Define an eMC Server entry and assign the eMC Server entry to the previously 
created Server Group.

3. Define an Email Db entry and assign this Email Db entry to the previously 
created Server Group.

Note: The eMail Center System Administrator Interface is an 
HTML based console and is separate from the Oracle Applications 
forms based Admin console.
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4. Define one database link and create two others. You will define the link from 
OES to the Apps instance created earlier, and you will create two links to your 
Email Db (your Oracle Email Server database). One link for user <oraoffice> 
(synchronize accounts) and one for user <OO> (mail manipulator accounts). In 
a single instance scenario, the database link would be self-referencing.

5. Define an Email Server entry and assign this Email Server to the previously 
created Server Group.

6. Enable the two queues (if they are not already enabled).

7. Create an account for every user.

References
For more information on defining Email Server accounts, refer to the following 
documentation:

Oracle eMail Center Concepts and Procedures

Oracle Email Server Administration Guide

Oracle Universal Work Queue Concepts and Procedures

Worksheet
Use the following worksheet to gather all the necessary information for completing 
the detailed tasks in the Defining Email accounts procedure.

Create Server Group

Note: You can choose to run your IMAP/POP and SMTP 
processes on the same machine as the Oracle Email Server or on a 
different machine. For detailed information, refer to the Oracle 
Email Server Administration Guide.

Note: For detailed information on creating entries in the 
Interaction Center drop-down list, refer to the Oracle Universal Work 
Queue (UWQ) documentation.

Group Name:_________________________ Group Description:___________________________
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Create EMC Server

Create Email Database Server

Create Database Link

Create Email Server

EMC Server Name:____________________ IP Address:__________________________________

DNS Name:___________________________ Group Server:________________________________

Database Name:_______________________ Service Name:________________________________

Host Name:___________________________ Database Description:_________________________

Port (SQL*Net port, default is 1521):______
___________________________

RT Availability:_______________________________

Protocol (default is TCP):________________
_____________

Group Server:________________________________

Database SID (GLOBAL_NAME of the 
database):_________________________

Server:_______________________________ User:_________________________________________

Name:_______________________________ Password:____________________________________

Email Server Name:____________________ RT Availability:______________________________

DNS Name:___________________________ Group Server:________________________________

IP Address:___________________________ Server Type:_________________________________

Port (Defaults 143 for IMAP, 147 for 
SMTP):_______________________________
__
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Create Account

Detailed Steps
Use the following procedures to define Email Server accounts.

Define Server Group
1. From the common CRM login screen (HTML), type the default system 

administrator user name and password.

The eMail Center System Administrator Interface appears, displaying the 
Server tab screen.

2. From the Server tab screen, click the Group sub-tab.

The Server Groups screen appears.

3. From the Server Groups screen, click Create.

The Create Group screen appears.

4. Type a group name and a group description in the provided fields.

5. Click Create to save the record.

The server group is created and you return to the Server Groups screen.

Define EMC Server
1. From the Server Groups screen, click the EMC sub-tab.

The EMC Servers screen appears.

2. From the EMC Servers screen, click Create.

The Create EMC Servers screen appears.

3. Type the EMC server name, DNS name, and IP address in the provided fields.

Name:________________________________ Email Server:__________________________________

Domain:______________________________ Interaction Center:______________________________

Profile:_______________________________

Note: If you do not see your new server group displayed, use the 
Next and Last commands to locate it in the list.
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4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. Click Create to save the record.

The EMC server is created and you return to the EMC Servers screen.

Define Email Database Server
1. From the EMC Servers screen, click the Email DB sub-tab.

The Database Servers screen appears.

2. From the Database Servers screen, click Create.

The Create Database screen appears.

3. Type the database name, hostname, port, protocol, SID, service name, 
description, and RT availability in the provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. Click Create to save the record.

The database server is created and you return to the Database Servers screen.

Create Database Link

Steps
1. From the Database Servers screen, click the DB Link sub-tab.

The Database Links screen appears.

Note: If you do not see your new EMC server displayed, use the 
Next and Last commands to locate it in the list.

Note: If you do not see your new database server displayed, use the 
Next and Last commands to locate it in the list.

Note: You will need to perform these steps three times. First for the 
<oraoffice> user and then for the <OO> user, then to define the link 
going from OES to Apps you created earlier.
Implementing Oracle eMail Center 55



Implementation
2. From the Database Links screen, click Create.

The Create Database Link screen appears.

3. From the drop-down list in the Server field, select the server.

4. Type the name, user and password in the provided fields.

5. Click Create to save the record.

The database link is created and you return to the Database Links screen.

Define Email Server

1. From the Database Links screen, click the Email sub-tab.

The E-mail Servers screen appears.

2. From the E-mail Servers screen, click Create.

The Create E-mail Server screen appears.

3. Type the email server name, DNS name, IP address, port, and RT availability in 
the provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. From the drop-down list in the E-Mail Server Type field, select the email server 
type.

6. Click Create to save the record.

The email server is created and you return to the E-mail Servers screen.

Note: If you do not see your new DB LinkName displayed, use the 
Next and Last commands to locate it in the list.

Note: You need to perform these steps twice. Once to define the 
IMAP server and once to define the SMTP server. IMAP is the 
protocol for the agent interface to talk to the server and SMTP is the 
protocol for communications across the internet.
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Enable Queues
1. From the E-Mail Servers screen, click the Queue tab.

The Advanced Queues screen appears.

2. From the Select column, click the check box for the two desired queues.

3. Click Enable to enable the two selected queues.

4. Once you have enabled the queues, click Refresh.

The Advanced Queues screen updates to reflect the new status for the selected 
queues.

Create Account
Follow the steps below to create the accounts you wish to have on your site 
(example: Classifications, or Support).

1. From the Advanced Queues screen, click the Account tab.

The Accounts screen appears, displaying information in table form for all 
current accounts.

2. Click Create.

The Create Account screen appears.

3. Type the account information in the provided fields.

4. Once you have provided the required information, click Create to save the 
record.

You are returned to the accounts screen and your new account is displayed in 
the table.

5. Repeat steps 2 through 4 for each account you wish to receive email.

Note: If you do not see your new email server name displayed, use 
the Next and Last commands to locate it in the list.

Note: You will need to perform these steps for every account you 
wish to receive email.
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Creating an eMail Center Agent
Once you have created your accounts on the Email Server, you can create your 
eMail Center agent user accounts. To create an eMail Center agent user accounts, 
follow the procedures provided in the Creating User Accounts topic.

Setting up Routing for Inbound Email
Follow the steps in the following chart to set up rules-based routing. The chart 
shows you where to read in detail about the setup step. The Window Names(s) 
column shows you in which window(s) you perform the step, and if the window is 
available only if you use a specific responsibility or product. The Required column 
shows you if the step is required, optional, required with defaults, or conditionally 
required.

Defining Groups
There are two types or groups for rules-based routing: static and dynamic. A static 
group requires that you manually edit information about individual group 

Note: To create an agent, you must first define the email server 
accounts.

Step 
Number Required? Oracle Sales Setup Step Description Window Name(s) AIW Reference

❏ Step 1 Required 
for 
rules-based 
routing

Define a group.

See: Defining Groups

Define Groups 
window; Dynamic 
Groups window

NA

❏ Step 2 Required 
for 
rules-based 
routing

Define a route.

See: Defining Routes

Routing 
Administration 
window

NA

❏ Step 3 Required 
for 
rules-based 
routing

Define the route priorities.

See: Defining Route Priorities

Routing Priority 
window

NA

❏ Step 4 Required 
for 
rules-based 
routing

Define the classifications.

See: Defining Classifications

Classification 
Administration 
window

NA
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members. In a dynamic group, the database automatically updates information 
about individual group members.

For procedures, see:

■ Defining a Static Group

■ Defining a Dynamic Group

Defining a Static Group  

Use this procedure to configure a static group for routing.

Prerequisites
None

Steps
1. Navigate to the Define Groups window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

b. Click Static Groups.

The Define Groups window appears.

Guidelines
When configuring static groups, use the following guidelines:

■ The Group Number and Group Name must be unique. 

■ If you want to prevent an agent from being shared with other groups, check the 
Exclusive Flag box to indicate that the agent belongs exclusively to this group.

■ You cannot create member records without choosing a Parent Group. 

■ When defining a static/dynamic group for Routing, the usage of the group 
should be set to ’Call Center’ so that the group will be available in the Routing 
Admin LOV for static/dynamic groups. 

Defining a Dynamic Group  

Use this procedure to configure a dynamic group for routing.
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Prerequisites
None

Steps
1. Navigate to the Dynamic Groups window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

b. Click Dynamic Groups.

The Dynamic Groups window appears.

2. If necessary, choose File > New.

3. Enter a unique name for the group.

4. From the Usage list, select the usage of the list.

5. Optionally, enter a description of the list.

6. Optionally, in the Active Dates area, select or enter the start and end date for the 
use of the group in routing.

7. Enter the SQL statement that selects the members of the group.

8. Click Check Syntax.

If the SQL statement is invalid, then an error message appears. If the SQL 
statement is valid, then no message appears.

9. From the File menu, choose Save.

Guidelines
■ When defining a static/dynamic group for Routing, the usage of the group 

should be set to ’Call Center’ so that the group will be available in the Routing 
Admin LOV for static/dynamic groups. 

Defining Routes
A route definition identifies the potential groups or members to which a call may be 
routed and the call parameters (such as ANI) to be used in determining the 
destination of a call.
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There are two types of routes for rules-based routing: static and dynamic. Static 
routing is based on data stored in cache. Dynamic routing is based on PL/SQL 
queries. Static routing is faster, but dynamic routing is more flexible. 

For procedures, see:

■ Defining a Static Route

■ Defining a Dynamic Route

Defining a Static Route  

Use this procedure to define a static route.

Prerequisites
❏ Define a group. For more information, see Defining Groups.

Steps
1. Navigate to the Routing Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

2. If necessary, choose File > New.

3. In the Route Definition area, identify the route.

a. Enter a unique name to describe the route.

b. From the Route Type list, select Static.

c. Optionally, enter the description of the static route.

d. If this route uses the Oracle Applications database, select Application 
Database.

e. If this route does not use the Oracle Applications database, select Non 
Application Database and enter the database driver and URL.

Note: If the route server cannot determine agents from the 
defined destinations, then the server routes the message to the 
default destination defined for the route.
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4. On the Route Destinations tab, select the groups to which calls may be routed.

5. On the Route Rules tab, define the parameters expected in an incoming call.

a. From the Key list, select a key (for example, ANI).

b. Enter the value for the selected key (for example, 888-555-1234).

6. From the File menu, choose Save.

Defining a Dynamic Route  

Use this procedure to define a dynamic route.

Prerequisites
None

Steps
1. Navigate to the Routing Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

2. If necessary, choose File > New.

3. In the Route Definition area, identify the route.

a. Enter a unique name to describe the route.

b. From the Route Type list, select Dynamic.

c. From the Default Destination list, select the default destination to be use 
when the Routing Server cannot determine a destination based on the 
procedure parameters.

d. Enter the description of the dynamic route.

e. If this route uses the Oracle Applications database, select Application 
Database.

f. If this route does not use the Oracle Applications database, select Non 
Application Database and enter the database driver and URL.

4. On the Route Destinations tab, define the procedure that is to be used to derive 
the destination for call.
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a. In the Dynamic Destination area, enter the name of the procedure 
(Package.Procedure) that is to be used to derive the destination for message.

b. In the Procedure Parameters area, identify the parameters for the 
procedure.

Sequence is a generated number that indicates the sequence of the 
parameter.

5. On the Route Rules tab, define the rules for the route.

a. From the Key list, select a key (for example, ANI).

b. Enter the value for the selected key.

6. From the File menu, choose Save.

Defining Route Priorities
You can define and change the priority of route definitions. Changing the value of a 
route priority affects the values of other route priorities. If you increase the value of 
a priority, then the priorities of all the routes with a value equal to or greater than 
the original value decrease by one. If you decrease the value of a priority, then the 
value of all the routes with a value equal to or less than the original value increase 
by one. For example, if you decrease 6 to 3, then 3 increases to 4, 4 increases to 5, 
and so on. If you increase 3 to 6, then 4 decreases to 3, 3 decreases to 2, and so on.

Use this procedure to set the priority for a route.

Prerequisites
None

Steps
1. Navigate to the Routing Priority window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Priority Administration.

The Routing Priority window appears.

2. From the Priority list, select a priority.

3. Click Change Priority.

4. From the File menu, choose Save.
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Defining Classifications
Classifications specify how to identify and route particular types of messages that 
are associated with the selected Route ID. Classifications are of two types: literal 
and database procedure. A literal classification is a string. A database procedure 
classification is a stored procedure.

Classification rules can determine the route that a call must take, or a classification 
rule can designate a message as a classification for reports or for screen pops. Every 
classification must have rules that define the conditions under which the 
classification occurs. When a message meets all these conditions, the classification is 
the result and the message is routed accordingly.

A classification can have multiple rules associated with it. An individual route can 
have multiple destinations, which can be either static or dynamic. Every route has a 
sequence of a Key and a Value whose relationship is determined by one of the 
available Operations (=, !=, >, >=, <, <=).

If an incoming routing request results in a new classification, the new classification 
is added to the route request as one of the parameters. The server tries to find a new 
route based on this route request.

For example, if the classification rules in the preceding table result in adding the 
new classification rule CLASSIFICATION=GOLD to the classification request, then 
a new route is determined based on the new rule.

For procedures, see:

■ Defining a Literal Classification

■ Defining a Database Procedure Classification

Defining a Literal Classification  

Use this procedure to define a literal classification.

Prerequisites
None

Note: If you configure a classification rule that results in a new 
rule, then you will need a route that is defined for that new rule.
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Steps
1. Navigate to the Classification Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Classification Administration.

The Classification Administration window appears.

2. If necessary, choose File > New.

3. In the Classification Definition area, define the classification.

a. Enter a unique name to describe the classification.

b. From the Type list, select Literal.

c. Enter the maximum amount of time, in seconds, that the Routing Server 
should spend trying to determine the destination.

d. If this classification uses the Oracle Applications database, select 
Application Database.

e. If this classification does not use the Oracle Applications database, select 
Non Application Database and enter the database driver and URL.

4. On the Classification Rules tab, define the rules for routing based on the keys 
identified in the route definition.

a. From the Key list, select a key.

b. From the Operation list, select an operator.

c. Enter the value for the selected key.

5. From the File menu, choose Save.

Defining a Database Procedure Classification  

Classifications specify how to identify and route particular types of messages that 
are associated with the selected Route ID. A database procedure classification is a 
stored procedure. The following conditions apply.

Note: A key used in a classification rule must be the same as that 
identified in the route rules definition.
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Prerequisites
None

Steps
1. Navigate to the Classification Administration window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin 
> Classification Administration.

The Classification Administration window appears.

2. In the Classification Definition area, define the classification.

a. Enter the name of the database procedure.

b. From the Type list, select Database Procedure.

c. Enter the maximum amount of time, in seconds, that the Routing Server 
should spend trying to determine the destination.

d. If this classification uses the Oracle Applications database, select 
Application Database.

e. If this classification does not use the Oracle Applications database, select 
Non Application Database and enter the database driver and URL.

3. On the Classification Rules tab, define the rules for routing based on the keys 
identified in the route definition.

a. From the Key list, select a key.

b. From the Operation list, select an operator.

c. Enter the value for the selected key.

4. On the Classification Parameters tab, identify the parameters for the database 
procedure.

Note: The name of the classification is not verified against the 
stored procedures. Be sure to enter the correct procedure name.

Note: A key used in a classification rule must be the same as that 
identified in the route rules definition.
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a. From the Parameter list, select a parameter.

b. From the Datatype list, select the data type of the parameter (for example, 
VARCHAR).

c. From the Direction list, select the direction of the parameter (for example, 
IN).

Sequence is a generated number that indicates the sequence of the 
parameter.

5. From the File menu, choose Save.

Configuring eMail Center Properties
Use this procedure to configure the properties for eMail Center. This procedure 
provides the UWQ Server with the URL to launch the eMail Center agent interface 
component. This step is only required when setting up the system for first time use, 
or after changing the Apache server root.

Steps
1. From the common CRM login screen, type the default system administrator 

user name and password.

The CRM default screen appears.

2. From the default screen, click the Advanced tab.

The Advanced screen appears.

3. From the Advanced screen, click the Properties sub-tab.

4. From the View drop-down list on the Properties sub-tab, select IEM.

A list of links should appear.

5. From the list, click the link iem.base.url.

6. Type the Apache server system root URL in the Value field (e.g. 
http://www.visioncorp.com/)

Note: If the list of links does not appear after step 4, click Create 
and the Create Key screen appears. Type iem.base.url in the Key 
field and move on to step 6.
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7. Click Update.

You return to the previous screen.

8. Click Update again to save all changes.

References
For more information, refer to the Administering Oracle eMail Center section of the 
Oracle eMail Center Concepts and Procedures documentation.

Configuring UWQ to Launch the Business Application
Follow the steps below to define the business application for Oracle Universal Work 
Queue to pop or start when emails are delivered to users.

Prerequisites
Any application that needs to be "popped" must be successfully installed, 
configured, and made available to UWQ. For more information on how to make a 
new application available to UWQ contact the UWQ Product Manager.

Steps
1. From the Self-Service (Forms) application, log in using an account that has 

access to the UWQ Administrator responsibility. 

2. Double click the UWQ Administrator responsibility.

The Media-Action-Classification-Association form appears.

3. Click the Media Type field and select the LOV.

4. Select a Media Type. (Example, Inbound Email).

5. Click the Classification field and type the classification for which you would 
like to associate the screen pop or Media Action.

6. Click the Media Action field and select the LOV.

7. Select Customer Care Media Function proc.

8. Repeat steps 5-9 to create additional Media Action Classification Associations.

Note: You must include the last slash (/) in the URL, as it is 
required.
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Creating Classifications and Themes

Overview
Resolving interactions involves two major challenges:

■ Understanding the intent of the communication. What is being requested or 
communicated?

■ Determining the appropriate responses or actions necessary to resolve the 
interaction

These challenges can be answered by human intervention (an agent reads and 
responds), a semi-automated process that requires human assistance, or a fully 
automated analysis and response.

A fully automated process requires three processes:

■ Beginning: Analyze the intent of the unstructured email message

■ Middle: Classify the intent

■ End: Suggest one or more responses to the message, based on the classification

Oracle eMail Center uses the iMT (interMedia Text) feature of the Oracle 8i database 
to analyze incoming email messages based on the linguistic properties of the 
various parts of the email, such as header, subject, and body. The term 
“classification” refers to the category under which the email should be classified. A 
good example of classifications for a hardware company would be Accessories, 
Service, Product Information, Installation, etc.

Each classification has a set of underlying theme signatures that are used by iMT to 
classify the email. Each theme signature for a classification has an associated score, 
which is used to order the classifications base on probability percentage.

This weighting methodology applies to theme signatures for responses as well. 
After a message is classified, eMail Center creates a search string based on the 
combination of the incoming message theme set and the response theme set. This 
search string is then used to query the MES database to retrieve the suggested 
response documents.
Implementing Oracle eMail Center 69



Implementation
Classifications and themes can be created in two ways:

■ By sending email to a “classification” email account

■ From the eMail Center Operations Manager Interface

Terms
Classification - the intent(s) of an email message.

Classification (as eMC sees it) - categories into which incoming email messages are 
sorted.

Classification Theme Signature - collection of themes and associated weights for 
the specified classification.

Response Selection Theme Signature - collection of themes and associated weights 
for responses to a specified classification.

Sample Message - a cleaned up message or piece of text whose contents are directly 
related to the characteristics of the classification.

Sample Response - cleaned up response or piece of text whose contents are directly 
related to the characteristics of responses for the classification.

Theme - keywords or phrases extracted from the text of the message or relative 
terms selected from the knowledge base.

Theme Signature - collection of themes and their associated weights.

Weight - signifies the relative importance of a particular word in a given theme.

Note: Please note the distinction between eMC classifications and 
the classifications derived by the routing server.

■ eMC classifications indicate the intent of a message.

■ Routing classifications are used in the UWQ GUI to display 
media items and may or may not relate to the intent of a 
message.

■ Routing classification can be the account name into which the 
email arrived.
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Creating Classifications and Themes by Sending Email
Use this procedure to create classifications by sending email to the "classification" 
email account.

Prerequisites
A “classification” email account should be created on the Email Server and should 
also be defined in the eMail Center.

Steps
1. Send an email to the “classification” account you created with the subject line 

reading:

<Classification Name><accountname@domainname><Q> OR

<Classification Name><accountname@domainname><R>

The letters ‘Q’ and ‘R’ above indicate whether the classification and corresponding 
theme signatures generated are for the incoming message (Q) or the outgoing 
response (R).

For example, if you created an email account called “support” for handling all 
support related issues and if you want to create a classification called “hardware” to 
categorize all hardware support issues, the email would have the following the 
subject line.

<hardware><><Q> OR <hardware><><R>

Based on whether you append the letter ‘Q’ or the letter ‘R ‘ to the subject line, the 
iMT will treat the email body as a sample inbound message or a sample response 
and generate themes with associated weights for the same.

References
For detailed information on creating email accounts on the Email Server, refer to the 
Managing Directory Information chapter of the Oracle Email Server Administration 
documentation (Creating Email Server User Accounts section).

Note: If the classification name specified in the subject line 
already exists, then the theme’s signatures (and their weights) will 
be updated for the existing classification based on the content of the 
email.
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For detailed information on defining Email Server Accounts in the eMail Center, 
refer to the Defining Email Server Accounts section of the Oracle Email Server 
Administration documentation.

Creating Classifications from the Operations Manager Interface
Use this procedure to create classifications from the eMail Center Operations 
Manager Interface.

Steps
1. From the Oracle Applications Operations Manager screen, click the 

Classification tab.

The Classification screen appears.

2. From the Classifications screen, click Create.

The Create Classification screen appears.

3. In the Classification Name field, type the classification name.

4. From the drop down list in the Email Account field, select the email account.

5. Click Create.

The classification is created and you return to the Classifications screen.

Creating Themes from the Operations Manager Interface
Use this procedure to create themes from the eMail Center Operations Manager 
Interface.

Prerequisites
The classification for which you are creating a theme must already be created.

Steps
1. From the Oracle Applications Operations Manager screen, click the 

Classification tab.

The Classification screen appears.

2. From the Classifications screen, click the Themes sub-tab.

A drop down list appears, displaying all of the existing classifications.
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3. From the drop down list, select the classification for which you wish to create 
themes.

4. Click Create.

The Create Themes screen appears, displaying the selected classification name.

5. In the provided fields, type the name and score for the theme you are creating.

6. From the drop-down list in the Type field, select the type of theme.

7. Click Create.

The new theme is created for the selected classification and you return to the 
Classifications screen.

Configuring Structured Email Templates

Overview
eMail Center includes a set of structured email templates (web forms). Structured 
email templates are HTML documents placed on an enterprise’s web server that can 
be filled out by a customer/prospect and result in the creation of a structured email 
when that customer/prospect clicks the Submit button. These templates can be 
used to leverage email as a tool to perform such tasks as create a service request, 
inquire about the status of service request, etc.

You can enable the included templates to submit email by pointing the HTML code 
for the templates to the correct web server and configuring the web server to handle 
the EmailGeneratingServlet. To do so, perform the tasks in the Modifying Existing 
Templates topic group below.

If the included templates are insufficient for your purposes, you can create your 
own custom templates. To do so, perform the tasks in the Creating Inbound Email 
Templates topic group.

Modifying Existing Structured Email Templates
This topic group provides steps for modifying the templates included with eMail 
Center.

Pointing the HTML Code to the Correct Web Server  

Use this procedure to point the HTML code for the templates to the correct web 
server.
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Steps
1. Modify the following line of HTML code to point to the correct server:

action="XXX/oracle.apps.iem.emailgen.EmailGeneratingServlet"

(Where XXX is the full path of the folder where the servlets are stored on the web 
server). This path should include the machine name, port information and the 
folder information.

For example: http://ap040sun.us.oracle.com:8000/jsp/

Configuring the Web Server to Handle the EmailGeneratingServlet  

Use this procedure to configure the web server to handle the 
EmailGeneratingServlet.

Prerequisites
Before performing this task, your web server must be installed and configured to 
run JServ or its equivalent.

Steps
1. Add the following line in the zone.properties file of JServ:

servlet.oracle.apps.iem.emailgen.EmailGeneratingServlet.initArgs=hostname
=<HOSTNAME>,to=EMAIL@DOMAIN

Creating Structured Email Templates
Templates are the structured email means by which customers can contact your 
interaction center. They are designed to provide information to eMail Center in a 
particular format that allows eMail Center to determine how to process the form. 
Forms are created as either User Interface forms or HTML forms, and are created 

Note: :80 is the default port number for eMail Center. You only 
need to indicate the port number in the above line if you wish to 
utilize a different port number.

Note: HOSTNAME refers to the name of the machine on which 
the SMTP server is running. EMAIL refers to the email account and 
DOMAIN refers to the domain on which the email resides.
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using virtually any HTML authoring application. Templates are created using any 
text authoring application.

Allowed HTML Form elements include:

■ Buttons

■ Check boxes

■ Radio Buttons

■ Menus

■ Text Input

■ Hidden Controls

Each form will present a different predefined structured email template; however, 
there must be a structured email ID tag hidden on each form. The look and feel of 
the page can be customized to suit your needs.

Before creating UI forms, you should first determine two things:

■ What is the purpose of the form?

Every organization (and often project) is different, having different needs when 
it comes to capturing and managing information.

The purpose of the web form could be one of the several things. For instance, to 
check the customer’s order status or it could be a service request. Based on the 
purpose, the content of the form would change. For example, if the organization 
is a service oriented organization, the forms would contain fields that would 
capture the type of service requested by the user, and all the other associated 
information. If the organization were to be selling products, the forms would be 
populated with their product details and the user would be requested to select 
the various available products, quantity required, type of product requested etc.

■ What data must be captured to support processing?

The required data fields of the form are totally dependent on the calling 
applications data requirements.

Consider a service related situation. Capturing the customer account number or 
service request number or a product serial number would be vitally important. 

Note: Applets, image files and Active X controls should not be 
part of the form.
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Capturing other useful information would be extremely helpful, but the ones 
that are mentioned above would be an absolute must, to ensure that the request 
is attended to by the eMail Center.

In a sales situation, capturing the customer’s contact information and perhaps, 
what products they are interested in would help to route it through the 
concerned department and give a response back to the customer.

In the case of general service information, it is possible to have a new customer, 
in which case, their contact information, their questions, concerns etc., would 
have to be obtained.

High-level Steps
The following steps assume you are using a HTML authoring application for 
creating inbound email templates:

1. Creating the title of the HTML form (template)

2. Creating the form tag

3. Create the hidden tag.

4. Adding form elements.

5. Adding validation logic.

Steps
1. Create the title of your HTML form (template).

Example for a service request form:

<H2><font color=red><u> Got a Problem?</u></font></H2>

<H3>Use this handy form to submit a service request.</h3>

 <p>*<b>Required Fields</b>

<br><b></b>&nbsp;

2. Create the form tag.

In this example the form has the name submit_problem. The form tag should have 
an action and a method. The action refers to the Servlet to which the information 
from this form is submitted. The method is a post referring to the HTTP protocol 
used to transfer the information from this form to the Server. OnSubmit performs 
error checking to ensure that all the required fields are entered and in order.
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<form name="submit_problem" 
action="http://servername.yourcompany.com/servlets/oracle.apps.iem.emailg
en.EmailGeneratingServlet" method= "post" onSubmit="return 
verifyfields(this)">

</Form>

3. Create your hidden tag. A hidden tag with the following value format must be 
part of each form (without this tag, the Servlet would not be able to process the 
request):

<EMAILTYPE>_<TYPE>_<SUBTYPE>

Example:

<input type="hidden" name ="tag" value = "WEB_SERVICE_CREATE">

Having created the form tag and hidden tag, follow the steps below to add form 
elements.

4. Create a table to format the other form elements in order.

<table width = 100%>

5. Add the text input field to capture the email address.

<td><blockquote><div align=right><b>Email 
Address<b></div></blockquote></td>

<td>*<input type="text" name="emailadd" value="" 
size=20></td><td>&nbsp;</td>

The first column <TD> holds the label of the form element and the second column 
holds the input box where the user can enter the information. Most of the other 
fields in this form are also text fields and the syntax for those are given in step 6.

Tag Value

EMAILTYPE Used to indicate web-based or text. If an email is generated 
from web-based email client, EMAILTYPE will be "WEB". 
Otherwise its value will be "TXT".

TYPE Denotes the request group, such as ORDER REQUEST or 
SERVICE.

SUBTYPE Represents detail information about a request, such as CREATE 
or STATUS.
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6. Add the remaining fields.

<td><blockquote><div align=right><b>Your 
Name<b></div></blockquote></td>

<td>*First Name</font>

<br><input type="Text" name="firstname" value="" size="20" 
maxlength="20"></td>

<td><div align=left>*Last Name

<br><input type="Text" name="lastname" value="" size="20" 
maxlength="20"></div>

7. Add the Submit and Reset buttons.

<td colspan=3><center><input type=Submit 
value=Submit>&nbsp;&nbsp;<input type=reset value=Reset> 

8. Close the table with a </table> tag.

Follow the steps below to add validation logic.

9. Add JavaScript Error Checking Code.

Ideally, you should place the JAVASCRIPT code within the head tags, but it can 
also be placed anywhere within the page.

10. Validate your form.

Uploading Structured Email Templates in iSupport
The steps below assume that the customer has also purchased the Oracle iSupport 
application, through which the end-user will be able to submit an email via an 
inbound template. If you do not purchase the iSupport application, then you will 
need to open Windows Explorer and copy the structured email templates to the 
$IEM_TOP / html directory for your web server.

Note: Error checking for required fields is mandatory to ensure 
that a proper automated response is sent back to the customer. The 
nature of error checking would depend on the type of form that is 
being submitted.
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Use this procedure to upload structured email templates into iSupport.

Prerequisites
Before performing this task, iSupport must be installed and you must have an 
administrator level login.

Steps
1. Login to Oracle iSupport as an administrator.

2. From the iSupport default screen, click the Email Templates tab.

3. From the Email Templates tab, click Add Email Template.

4. In the Template Name field, type the name of the template.

5. In the Template Location field, type the location of the template.

6. Click Create.

References
For more information on uploading inbound templates to iSupport, refer to the 
Oracle iSupport documentation.

Note: Since the templates (HTML files) are referenced and not 
physically stored in the application, the administrator should be 
aware of the exact location of these files on the web server. 

Note: Use a name that best describes the template.

Note: Be sure to enter the full path (including the file name) for 
the location.

Important: You can update the location of a previously loaded 
template, but you cannot update the name. To update the name of 
the template, you must first remove the existing template and 
upload the template again with a new name.
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Verifying The Template is Referenced Correctly
Use this procedure to verify that you have referenced the template correctly in 
iSupport.

Steps
1. Login to Oracle iSupport as an administrator.

2. From the iSupport default screen, click Email.

3. Select the template you wish to verify by clicking the corresponding check box.

4. Click Continue.

The application should now be able to successfully display the contents of the 
template.

References
For more information on verifying the contents of the template in iSupport, refer to 
the Oracle iSupport documentation.

Configuring Automated Response Documents and Associated Queries

Overview
Automated responses to structured and unstructured inbound requests are handled 
by Oracle Fulfillment. Oracle Fulfillment is one of the CRM foundation products 
and should already be installed. The response documents in Fulfillment are referred 
to as “Master Documents”, and they may or may not have a query associated with 
them. If the master document has one or more merge fields, then it should have an 
associated query to populate those merge fields. The number of columns in the 
select clause of the query should equal the number of merge fields in the master 
document.

Creating Automated Response Documents
You can create email forms and apply a query to generate a personalized outbound 
email. Automated response documents are created using any HTML editor. As 
stated earlier, prior knowledge of HTML is assumed here. Before creating an email 
template, you must identify the query containing the desired result set for the 
document. Release 11i of eMail Center will only support one query per email 
template; however, multiple email templates can use a single query.
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The only dynamic content that eMail Center allows is the use of Merge fields and 
fragments. Merge fields were explained in the previous section. Fragments are zip 
files, which are stored in the MES tables.

The directory structure of the zip file must be organized in the following manner: 
place all HTML files and an images directory in the root. Place all associated images 
in the images directory.

Rules for Using Merge Fields and Fragments
A set of rules governs the use of both merge fields and fragments. The guidelines 
for using the merge fields and fragments are mentioned below.

1. HTML documents can be created following HTML standards. These documents 
should be in directory. That directory’s structure should be a parent directory in 
which all the HTML files would reside, and an images directory in which all the 
associated images would be placed. The HTML files and an images directory 
with all the images associated with the HTML files would be zipped together 
and be available as a zip file. Release 11i 1-to-1 fulfillment will only support 
static images. This means images cannot be included in a HTML file as a merge 
field or as Fragments. Any image included in the HTML document needs to be 
in the images directory and the path of the image should point to the images 
directory.   For instance, in the response to Please Call Me form, a reference to 
the oracle logo would be like:

<img src="images/oraclelogo.gif"> 
�

2.  The list of available Merge Fields from the query will be in the file merge_
fields.txt (or any other name that you gave) that you previously created using 
the create data source button. (As explained in the previous section- Getting 
bind variables for a Query).

3. Bind variable names are case sensitive. When bind variables are used, they 
should be used exactly as they are referred to in the file that was created earlier. 
Cutting and pasting the bind names from the file merge_fields.txt would solve 
the problem.

Note: The HTML file and the images directory are in the same 
level. All associated images should reside in the images directory.
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Rules for Creating Automated Response Documents
1. Merge fields must be surrounded by the following special tag and special 

characters.

The tag that should surround the merge field is:

<span style=’mso-field-code’>&#171;  &#187;</span>

Mergefield can be placed in the middle as shown in the following example:

<span style=’mso-field-code’>&#171;Mergefield&#187;</span>

The Mergefield place holder is highlighted. Bold letters indicates the special 
tags and special characters that enclose the merge field. The highlighted 
Mergefield is just a place holder. The actual Merge field should be placed there 
in the document.

�

2. If merge fields are embedded in an HTML table, the table can only have two 
rows. The first row must be the table header and the second row should hold 
the merge fields. In such an instance, the data must be repeated for the number 
of times the rows are returned by the query.

3. Fragments cannot contain merge fields inside them. Fragments are zip files 
containing HTML files and an image directory with all associated images 
placed under it. This directory structure must be maintained all the time.

4. The tags surrounding the fragments are:

<span style=’fragment-field-code’ >&#171; &#187;</span> 

The Fragment ID would go in the middle as shown in the following example:

<span style=’fragment-field-code’ >&#171;FragmentID&#187;</span> 

Create an Associated Query
Use this procedure to create a query in Fulfillment before associating it with a 
master document.

Prerequisites
Before performing this procedure, Oracle Fulfillment must already be installed.

Important: Merge Fields are case sensitive and should be referred 
to exactly the same as they were obtained from the query.
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Steps
1. From the common CRM Login screen, login as the Fulfillment administrator.

2. Click the Query tab.

3. Click Create.

4. In the “Create Query” screen, type in data for the following fields.

■ Query Name - this name should be unique.

■ Query Description - a brief description of the query.

■ Query String - this is the SQL statement for the query. The number of fields 
in the “Select” clause should equal the number of merge fields in the master 
document. Do NOT end the query with a “;” or “/”, the standard SQL 
syntax to execute the query.

■ Application Database - the database instance against which the query 
should be run.

■ Application User Name - the userid of the account that should be used to 
run the query.

■ Application Password - the password for the above userid.

5. Click Create.
�

Uploading Automated Response Documents and Associated Queries
Use this procedure to upload an automated response document in Oracle 
Fulfillment and associate a query (if required).

Prerequisites
Before performing this procedure, Oracle Fulfillment must already be installed.

Steps
1. Login to the CRM application as a fulfillment administrator.

2. Click the Template tab.

3. Click the Master Document sub-tab.

Important: Once you create the query, please note the Query ID 
number. You will need this ID number for the verification process.
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4. Click Upload.

5. Type the full path for the filename, or click Browse to browse through your 
local file system.

6. After selecting the file click Upload.

A screen appears that alloys you to associate a query if required.

7.  In the Description field, type a brief description about the document.

8. From the Query drop-down list select the associated query name. If you don’t 
wish to associate any query select No Query which is also the default option.

9. Click Upload to complete the process of uploading a master document and 
associating a query to it.

Uploading Suggested Response Documents

Overview
Oracle eMail Center (eMC) uses the Marketing Encyclopedia System (MES) as its 
document repository. This topic group describes the process of uploading response 
documents into the response document repository (also referred to as KB or the 
knowledge base). MES stores documents under different categories. 

eMail Center requires a category called “EMC Templates” to store the email 
templates. These templates are standard email responses that an agent may use to 
respond to an inquiry and should not be confused with the “inbound templates” or 
customer service web forms that are uploaded in iSupport. Currently, eMail Center 
ONLY searches the “EMC Templates” category for email templates and all available 
categories for suggested responses.
�

High-level steps
1. Create the category in MES (only performed once).

2. Define a hierarchy among categories (only performed once).

Important: We are also assuming that the customer has purchased 
iSupport (for the purpose of uploading inbound email templates). If 
the customer has not purchased iSupport, they should be aware of 
steps that need to be performed to reference the standard set of 
templates provided by eMail Center on their web server.
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3. Create a suggested response document.

4. Upload the documents into MES.

5. Verify the document was uploaded.

6. Create and upload an associated query (only if the document has merge fields).

7. Associate the suggested response document and the query.

References
For more information on MES categories, refer to the Oracle Marketing Online and 
Oracle Marketing Encyclopedia System documentation.

Creating a Category in MES
Use this procedure to create a category in MES for the response templates.

Prerequisites
You must have a valid administrator login account.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Administration sub-tab.

4. From the MES Administration sub-tab, click Category Manager.

The Category Manager screen appears.

5. In the provided fields, type the name of the new category and a description of 
it.

6. Click Update.

Oracle Marketing Online creates the new category.

Defining a Hierarchy Among the Categories
Use this procedure to define a hierarchy among categories by creating 
sub-categories.
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Prerequisites
Before you can define a hierarchy among categories, you must first create the 
categories as shown in the Creating a Category in MES topic.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Administration sub-tab.

4. From the MES Administration sub-tab, click Hierarchy Manager.

The Hierarchy Manager screen appears, displaying a list of child and parent 
categories.

5. From the list of child categories (on the right column), select the desired child 
category.

6. From the drop-down list in the Parent Name (left) column, select the 
corresponding parent category.

7. Click Update.

Oracle Marketing Online links the child category to the selected parent 
category.

Creating a Suggested Response Document
A suggested response document can be a Word or an HTML document that may or 
may not have merge fields. A merge field is a place holder, for a variable which gets 
automatically filled when a query associated with document is fired. The associated 
query is executed when a response document is selected. The merge fields need to 
be enclosed within special tags, “«”, which can be entered by holding down the 
“Alt” key and typing “0171” on the numeric keypad (with the Num Lock Turned 
off), and “»”, which can be entered by holding down the “Alt” key and typing 
“0187” on the numeric keypad (with the Num Lock Turned off). Example:

Dear «CP_FIRST_NAME» «CP_LAST_NAME»,

Thank you for your interest in «PRODUCT_NAME». This product will be 
released on «RELEASE_DATE».
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Uploading Documents Into MES
Use this procedure to upload response documents into MES.

Prerequisites
Before you upload response documents into MES, you must first create a category.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Publish sub-tab.

4. From the drop-down list in the Item Type field, select an item type.
�

5. In the provided fields, type a title, author name, and description.

6. From the drop-down list in the Content Type field, select a content type.
�

7. Leave the Content Creation Date and Effective Start Date fields blank.

8. From the drop-down list in the Duration field, select the Permanent radio 
button or enter a value and a time period for that value.

9. Select a priority for the document.

10. Do not click the Create distribution rules on publish check box.

11. From the Category field, click Find.

The Find screen appears, displaying a list of the categories.

12.  From the list, select the corresponding category.

Note: For response documents, you should select the item type 
File.

Note: For response documents, you should select the content type 
Master Document.
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13. Click Upload File.

14. Click Browse to browse through the file system.

15. From the file system, select the desired document.

16. Click Open.

The entire path for the selected document is now displayed under File Name.

17. Click Attach File.

The file uploads. Once the file has fully uploaded, the File Name is no longer 
displayed.

18. Once the file uploads and the File Name disappears, click Finished.

The file name should display under Files.

19. Click Publish.

A success message will be displayed on the top of the screen in red letters.

Verifying the Document Uploaded Successfully
Use this procedure to verify the document successfully uploaded into MES.

Note: You can expand the category tree by clicking the (+). Once 
the parent category expands, click the desired child category name 
to select it.

Important: Do not click any other button until the file has fully 
uploaded, or the upload process will fail. Also, if the response 
document contains one or more inline images, then please repeat 
steps 14 through 17 for every image file (.gif or .jpeg) that needs to 
be included in the response document.

Note: To publish another document you must start by clicking 
Publish sub-tab again. Do not try to use (re-cycle) data entered for a 
previous file. 
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Prerequisites
Before you verify the success of your upload, you must first complete all the steps 
in the Uploading Documents Into MES topic.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Categories sub-tab.

4. Click the category name under which you uploaded your response documents.

The name of the file and its description should appear. If not, go back and 
repeat the steps listed in the Uploading Documents Into MES topic.

Create an Associated Query and Upload it
You need to associate a query with a response document only if the document has 
merge fields that need to be filled automatically based on some input parameters. 
Refer to the Create an Associated Query section to create an associated query and 
upload it.

Associate the Suggested Response Document and the Query
To be able to associate the suggested response document and the query to expand 
the merge fields in the document, you will need to have the following data:

Document ID

Query ID (which you should have obtained by performing the steps in the 
section above)

To obtain the document ID, currently you have to run the following SELECT 
statement in SQL*Plus:

SELECT ITEM_ID

FROM JTF_AMV_ITEMS_TL

Note: After uploading the query, click on the query name, now 
displayed in the table under the Query tab. Make a note of the 
QUERY ID for the query you just uploaded. You will need this ID 
to associate the query with the response document.
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WHERE ITEM_NAME = ’DOCUMENT_TITLE’;

(Where DOCUMENT_TITLE is the title of the suggested response document you 
uploaded in MES).

To associate the suggested response document with the query, currently you have to 
run the following INSERT statement in SQL*Plus:

INSERT INTO JTF_FM_QUERY_MES

VALUES (DOCUMENT_ID, QUERY_ID, SYSDATE, USER_ID, SYSDATE, 
USER_ID, NULL, NULL, NULL);

Where DOCUMENT_ID is the document ID of the suggested response document 
obtained by running the SELECT statement above.

QUERY_ID is the ID of the uploaded query (noted when the query was uploaded)

SYSDATE is a system variable provided by SQL*Plus that always has the value of 
the current system date. 

USER_ID is the user ID for the account you used to log in, e.g. 11001

NULL values are inserted in the final three columns since they are not related to our 
product

Using Email Processing Workflow
A rules engine (error processing) needs to be setup to process unstructured email 
through eMail Center. The backbone of rules engine is created by using Oracle 
Workflow, which is a part of Oracle Applications 11i. The name of the workflow for 
unstructured eMail Processing is “Email Preprocessing”. The rules engine must be 
configured onsite to cater to the various business rules and requirements of the 
client.

This topic group provides an overview of both unstructured and structured 
workflows, a high-level view of the steps involved in configuring operations for 
workflows, and detailed instructions for performing each of the configuration steps.

Error Processing
Errors that occur during eMail Center processing cannot be directly returned to the 
agent, since the agent and/or caller generally does not know how to respond to the 
error (in fact, eMail Center may be a background engine with no human operator). 
You can use Oracle Workflow Builder to define the events you want to occur in case 
of an error. Use Oracle Workflow Builder to modify the default error process 
associated with the process or create your own custom error process.
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The error process can include branches based on error codes, send notifications, and 
attempt to deal with the error using automated rules for resetting, retrying, or 
skipping the failed activity. Once you define your error process you can associate it 
with any activity.

Defining Workflows
To build or modify workflows, you use the Oracle Workflow Builder application. 
Oracle Workflow Builder lets you create, view, or modify a business process with 
simple drag and drop operations. Using the Workflow Builder, you can create and 
modify all workflow objects, including activities, item types, and messages.

Although unstructured and structured email processing workflows are referred to 
separately, there is only one workflow with multiple paths, one of which being 
structured.

Email Processing Workflow

Terms to know
Activity - A unit of work performed during a business process.
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Node - An instance of an activity in a process diagram as shown in the Process 
window.

Process - A set of activities that need to be performed to accomplish a business goal.

Workflow - A workflow is a processing path, consisting of a series of process nodes 
linked together to form paths that support a particular business rule or set of 
business rules.

Unstructured Email Processing Workflow
The “Email Preprocessing“ workflow contains some mandatory nodes, which must 
be setup to get messages processed and passed to the eMC server.

These mandatory nodes are:

Note: These seven mandatory nodes must ALL be present in the 
workflow or the workflow will fail.

Node Name Function

Check Authorization Checks whether the message coming for the user is a 
valid eMail Center user. If not, it discards the message.

Structured Mail? Checks whether the message is structured or 
unstructured. If the message is structured, it calls the 
structured workflow processing.

Structured Mail 
Processing

Calls the structured workflow to process the message as 
a structured workflow.

Check User Group Routes the message depending on the account for which 
it was sent. For example, if the message was sent to the 
"Support " account, then it branches to the path for 
Support.

Classification Theme 
Repository

Processes the classification and theme. Stores the query 
and response themes for each classifications.

Message Header 
Processing

Processes the message header.

Extended Header 
Processing

Processes the extended header.
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The “Email Preprocessing“ workflow also contains some nodes that are not 
mandatory, but are essential to enhance the functionality. 

These nodes are:

The Structured Email Processing Workflow
Structured inbound email occurs when a customer completes a well defined form 
whose template was on a web site or received in an email message sent to the 
customer.

eMail Center has only one workflow for all that it does. The workflow, however, is 
comprised of paths for unstructured and structured inbound email. Earlier in this 

Theme Classification 
Processing

Classifies the incoming message and extracts the themes.

KB Specific Search Searches the knowledge base to retrieve related response 
documents.

Entering Queue Places the message in a queue after Processing. eMC 
Server retrieves the message from this queue and 
processes it further.

Node Name Function

Extract Key Value Retrieves the service request number.

Order Status Communicates between Fulfillment and eMail Center. 
Returns the response documents containing the service 
request status.

Qualify For 
Autorespond

Checks whether a auto-response from eMail Center 
should be sent or not depending on the attribute value 
“Threshold score”. Depending on the value of the 
threshold score, if the top classification score for the 
message is achieved or exceeded, the Autoresponding 
node is triggered.

Autoresponding Autoresponds to a sender with a set of documents 
having a score greater than the value of “Document 
Threshold Attribute”.

Node Name Function
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document, the unstructured workflow was shown with one path repeated several 
times to accommodate each user group.

In contrast, structured workflow has 12 different paths shown here, plus one path 
for invalid messages. Those 12 paths are labeled:

■ New Customer

■ Tell Me More 

■ Bug Report

■ Service Request Status

■ Call Me

■ Customer Service Request (How may we help you?)

■ Create Service Request (Got a problem?)

■ Order Status

■ Cancel Order

■ Cancel Back Order

■ Dispatch/Service Call Request

■ Update Customer

All 12 paths share two common end points, one for success and one for failure. The 
invalid message path goes only to the failure end point.

Service Request Status (example)  
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Structured Email Processing

Node Name Function

Get Message from IM 
APIs

Extracts the message content from the email server

Is Structure Valid? Checks to see if the email is a structured email

Get Email Type Checks to see if the email is web or text based

Is Message data correct 
and complete

Checks to see all the required data is complete and 
correct

Notify Sender of Invalid 
Message

Sends email back to sender if the email contains invalid 
data

Parse Web Message Extracts the required data from the web based email
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Parse Text Message Extracts the required data from the text based email

Get Request Type Extracts the type of request sent by the sender

Auto Acknowledge 
Reply to Sender

Sends an acknowledgment of receipt of the email request 
to the sender

Create Customer Creates a new customer record in the database

Create Outbound 
Response

Sends the processed response back to the customer

Create Callback Creates a record in the database for a call back

Notify Application Indicates completion of the process

Verify Customer Checks to see if the customer is a valid customer

Is it a lead? Checks to see if the customer is a lead

Lead Capture Creates a new lead in the database

Process Bug Report Creates a new bug in the database

Get Status from SR Returns the service request status from the database

Send Service Request 
Status

Sends the service request status to the customer

Create Callback Task Creates a callback task in the database

Create Service Request Creates a new service request in the database

Get Status from Order 
Capture API

Gets the status of the order from the database

Order Capture Order 
Cancellation

Cancels a previously placed order

Cancel the Back Order Cancels a back ordered order

Process Dispatch Call 
Request

Creates a dispatch call

Update Customer 
Information

Updates the customer information in the database

Node Name Function
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Creating a Workflow Process
The following high-level steps comprise configuring workflow properties for using 
default workflow processes and/or creating the new workflow process or node:

1. Creating the Lookup Codes

2. Using a node

3. Setting the User ID

4. Configuring the Global Attributes

For configuring the default unstructured workflow process, follow steps 1 and 4.

For configuring the default structured workflow process, follow steps 3 and 4.

For creating a new unstructured process, follow steps 1, 2, 3, and 4

For creating a new structured process, follow steps 2, 3, and 4

Creating the Lookup Codes  

Lookup codes are used in the workflow to link the email accounts with their 
respective workflow paths or processes. eMail Center ships with a set of default 
Lookup Codes, such as Support. These lookup codes should match the email 
accounts created in the Email Server (Refer to Creating Email Server Accounts) and 
defined in the eMail Center (Refer to Defining Email Server Accounts). If the 
account name does not match the default lookup codes, follow the steps below to 
create a new lookup code.

Steps
1. Login to Oracle Workflow Builder.

2. Select process->Mail Preproc (this selects the mail preprocessing workflow).

3. Double-click the screen.

In the Workflow Builder, Mail Preproc gets loaded.

4. From the Navigator screen of Oracle Workflow Builder, click Lookup Type.

5. Select IM User Address.

A list of default lookup codes appears.

6. Right-click IM User Address.

7. Select New Lookup Code.
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The Lookup Code screen appears.

8. Enter the following data:

■ Internal Name - this is the email account name that was created in IM and 
defined in the eMail Center. For example, you can enter "Marketing" for the 
Marketing account.

■ Display Name - this is the descriptive name that appears in the lookup 
code. (The Oracle Workflow Builder recommends that the Internal Name 
and Display Name are different).

9. Click OK.

Using a Node  

This topic provides a high-level overview of the steps necessary to use nodes when 
building a workflow.

Steps
1. Login to Oracle Workflow Builder.

2. Select process->Mail Preproc

3. Double-click the screen.

In the Workflow Builder, Mail Preproc gets loaded.

4. From the Workflow Builder navigator, select Function.

All available nodes appear.

5. Drag and drop the desired nodes into the Process diagram.

6. Select either TRUE or FALSE for boolean return types.

7. Repeat steps 5 and 6 until you have made all desired changes to the workflow.

8. From the Workflow Builder main menu, select Verify.

Workflow Builder checks the verification of the new workflow.

9. If the verification is successful, save the new workflow to the database.

Setting the User ID  

Structured email processing responses come from the Fulfillment server, so you 
must be set up as a valid user in Oracle Fulfillment before you can receive a correct 
response.
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The user ID is set up as a look up in the FND_LOOKUPS table and it is seeded 
there. The value of the user ID is retrieved using the following query:

select meaning

from fnd_lookups

where lookup_type = ’IEM_USERID’

To determine whether the value returned by the query is a valid fulfillment user, 
check the returned value with the fulfillment server. If not, you must change the 
value.

Configuring the Global Attributes  

Use this procedure to customize the global attributes for structured and 
unstructured workflows.

Steps
1. Log in to the Oracle Workflow Builder as Oracle Applications User.

The Show Item screen appears, displaying a list of items.

2. From the list of items in the Show Item screen, select Email Preprocessing for 
unstructured, or select Structured Inbound Email Process for structured.

3. Click OK.

The Workflow Builder loads the workflow.

4. Configure the global attributes.

■ Set the following global attributes for unstructured:

Attribute Name Value

Repository Name Pre-seeded with ’SMS,MES’.

If other repositories are required, they must be added 
here.

Application ID Application ID that loaded, and therefore owns, 
documents into Marketing applications.
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■ Set the following global attributes for structured:

Extended Headers Currently picking up five extended headers that come 
with a message. The headers are pre-seeded with the 
following values:

Extended Header 1: MESSAGE-ID

Extended Header 2: ORGANIZATION

Extended Header 3: MAILER

Extended Header 4: LANGUAGE

Extended Header 5: CONTENT-TYPE

These attributes are retrieved from the messages and 
passed to the eMC Server.

These values can be changed to meet user 
requirements.

Value For Key Pre-seeded with the phrase "service request number is". 
If this phrase appears in the message body, the 
customer is asking for a service request status.

If customers want to send something different, this 
value must be changed.

Service Request User ID Defines a valid fulfillment user ID.

Before setting this value, check with the fulfillment 
service group to locate a valid user ID.

Service Request Document ID Defines a valid fulfillment document ID.

Before setting this value, check with the fulfillment 
service group to locate a valid document ID.

Attribute Name Value

SR DOC ID The service request document uses this attribute 
as an ID for returning the service request status.

CREATE SR DOC ID The create service request document uses this 
attribute for returning the service request creation 
details.

Attribute Name Value
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Troubleshooting
This topic group describes ways of troubleshooting various problems that arise 
while installing, starting, and running Oracle eMail center. This chapter discusses 
problems in the following areas:

■  Installation

■  Configuration

■  Starting

■  Logging on

■  Running

■  Performance

Installation

IM_IMT_EXTN Error
If you experience an error during eMail Center workflow processing with this 
package (IM_IMT_EXTN), contact the Metalink for the necessary patch. 

iMT Processing Error
Ensure that your LD_LIBRARY_PATH environment variable contains $ORACLE_
HOME/ctx/bin for the external procedure LISTNER calls.

Configuration

Manual Step(s) in question? 
Refer to the Implementation section on Modifying Existing Structured Email 
Templates. Generally means that you have not added the config line to the 
zone.properties of your web server and/or pointed your HTML forms to the correct 
web server.

eMail Center does not function in a multiple-instance scenario
Oracle eMail Center can integrate to multiple instances. Refer to the Post-installation 
Steps (Server Side) section in this guide. The default is single-instance.
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Classifications can not be created.
The classification account has not been configured and/or is improperly 
configured.

After upgrading the Oracle database, the Oracle eMail Server (Internet 
Messaging Server) does not work.
You must relink the eMail Server after any database upgrade (e.g. 8.1.6.1 to 8.1.6.2). 
To relink, you must create three (3) targets depending upon the Oracle eMail Server 
options you have installed. If you have installed all three (3) options, you need to 
run make for all three (3) targets.

■ $ cd $ORACLE_HOME/office/lib

■ $ make -f office.mk coreinstall

■ $ make -f office.mk psinstall

■ $ make -f office.mk adminstall

Starting

Unable to launch agent interface
Check your system profiles.

Are your agent folders created?

Logging On
There are a variety of reasons why you may not be able to log on. You can use the 
JInitiator console to look at the process trail of events to determine why you were 
not able to log on.

Some of the possible problems with logging on include:

Unable to log on to Self Service Applications
Make sure that the Forms server and the database are up and running. Enable 
Jinitiator console for monitoring and if the error states ?Out of Memory?, clear the 
contents of the jcache directory. This directory is typically located in 
C:\Program\Files\Oracle\JInitator\jcache
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Unable to log on to CRM e-Business Suite
Make sure that the Apache server is up and running. Set up user and password 
correctly. Make sure that the System Profiles have been set up correctly.

Passwords are case-sensitive and you used the wrong case.

You forgot your password or you used an incorrect password. There is no way to 
determine your old password but your administrator can assign a new password.

Your account may not be properly configured. Your administrator can make 
required changes to your account configuration.

You were logged on but the system logged you off.

eMail Center allows only one log on per user, someone else may have used your log 
on.

Running

Emails not being processed
Make sure that the Oracle Email Server is up and running, EMC Server is running, 
OTM Server is running, UWQ is running

Not getting automated email responses
Check if the Fulfillment server is up and running, Master Documents are loaded in 
Fulfillment

Documents not being retrieved
Load documents into MES

No structured response generally means that the Fulfillment server is not running.

Template merge is incomplete
Two types of merge fields (straight-insert & query) are supported in the eMail 
CenterTemplate/Suggested Response Merge functionality.   This error generally 
means that not all of the straight-insert data was available.

 Email failed to reach AQ1
This generally means that the Oracle Email Server db link does not exist. Refer to 
Implementation section of this document.
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Email fails to reach account inbox
This generally means that the email account (e.g. support@...) has not been 
configured to deliver emails to AQ1.

Email goes to retry folder
This generally means that the concurrent manager is not running.

Unable to transfer message
This generally means that the other agent’s folder(s) do not exist.

Themes are not being created
Refer to the Creating Themes from the Operations Manager Interface section of this 
guide.

Customer Support/Universal Work Queue Selector not displayed
This generally means that the Forms server is not running and/or you do not have 
proper privileges.

Unable to display UWQ desktop
This generally means that JTF has updated the package and didn't follow the safe 
package spec. guidelines, causing dependent Forms to get out of sync. with the 
package. Rebuild all of the existing IEU Forms components (PLSs/PLLs and 
FMBs/FMXs) and this problem will go away.

Failed to launch HTML application
Generally means that the incorrect component is being specified.

Markup text does not work
Oracle interMediaText currently works only in English.

Markup text does not find relevant information
Tweak the linguistic processing module by customizing the theme. For additional 
information refer to Oracle interMediaText (iMT) documentation.

New email classification failed
Use sample messages for your classifications that completely represent the subject 
matter anticipated in emails belonging to the classification.
104 Oracle eMail Center Implementation Guide



Glossary
The auto response failed
Check your threshold settings for confidence scores on incoming message 
classification.

All classifications were not displayed
The system maximum is seven (7).

Agent Interface

Unable to compose/create message
Classifications are not being displayed.

The agent interface failed to find your theme related documents. Verify that your 
documents are contained within the Marketing Encyclopedia systems repository. 
View your documents from the agent interface MES tab.

Performance

The maximum system browser cache is inadequate for your memory
 Clear your cache.

The agent interface is partially displayed and/or you must scroll to view 
the entire desktop
Increase your display resolution to 1200 by 1000 and maximize displayed window.

Access speed depends largely on your network architecture and somewhat on your 
PC processor and memory.

New and/or modified workflow processes do not function and/or poorly 
perform and seem to hang
Verify your logic and query design. Isolate and analyze the suspected query. Create 
test cases.

Glossary
Agent Interface - The eMail Center email browser

Apache - A third party web server
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Applet - A Java program that runs in the Internet browser

Browser - Application that helps in accessing the Internet (Internet Explorer and 
Netscape)

Classification (email) - The main subject of the email

Client Desktop - Also referred to as the agent interface. The eMail Center email 
browser

Customer Care - Oracle Product

Distribute - Means that it puts the email into the queue of the agent or agent group 
that the router identified

Domain - Refers to the domain name in which the email resides

eMail Center - Oracle Product

Fulfillment - Oracle Product

Hostname - Refers to the name of the machine on which the SMTP server is 
running

interMedia Text - Oracle Product

iSupport - Oracle Product

Java - Programming Language

Knowledge Base - A repository of documents that can be queried

Multiple Instances - CRM and OES are installed in different databases

Response Template - The template that will be used to reply to customers

Single Instance - CRM and OES share the same database

Structured email - An email whose content and structure are known

Unstructured email - An free form email

Web Template - A web page that accepts user input and creates a structured email

Work Queue - A logical queue that holds each Agent’s emails

Related Documentation and Resources
The following list of documentation serves as a reference set of documents for 
installing and implementing Oracle eMail Center:
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Oracle Documentation
■ Oracle Applications Concepts, Release 11i

■ Oracle Applications Installing Oracle Applications, Release 11i

■ Oracle Applications Implementing CRM Applications, Release 11i

■ Oracle eMail Center Technical Reference Manual, Release 11i

■ Oracle eMail Center Concepts and Procedures, Release 11i

■ Oracle Telephony Manager Installation Guide, Release 11i

■ Oracle Call Center Applications Setup, Release 11i

■ Oracle CRM Foundation Components Concepts and Procedures, Release 11i

■ Oracle Email Server 5.1

■ Oracle BR100 Planning Guide

■ Oracle Fulfillment, Release 11i

■ Oracle iMarketing Concepts and Procedures, Release 11i

■ Oracle Marketing Concepts and Procedures, Release 11i

■ Oracle Marketing Encyclopedia System, Release 11i

■ Oracle Applications System Administrator’s Guide, Release 11i

■ Oracle Email Server Administration Guide

Other Documentation
■ Any HTML authoring guide

Web Sites
■ http://developer.netscape.com/software/signedobj/jarpack.html

■ http://developer.netscape.com/docs/manuals/signedobj/signtool/index.ht
m

Referencing TARs and Patch Information
❏ For BUG/TAR information: 

■ Reference the Oracle BUG Database at http://bug.us.oracle.com

❏ For Patch information: 
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■ Patches are available for download from ARU and/or from MetaLink or 
TCPatch. 
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